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UPGRADE YOUR DOCUMENTS

AFTER THE VISION Pro bonanza over the
last two issues, the latest issue of
Mac|Life is looking decidedly more
conventional. That’s not to say Vision
Pro has quietly gone away until its
penned release next year — just
recently Unity stated that it’s inviting
visionOS developers to sign up for beta
access to its games development
platform, PolySpatial, which is
promising news. Sure, many of you
might not be gaming fanatics, or believe
that access to an extensive games
catalog will make Vision Pro worth
investing in, but it’s nice to know that
things are definitely moving along in
the wake of the launch. I, for one, am watching this space.

In the near future, though, we’re still patiently waiting for the
public release of Sonoma, i0S 17/iPadOS 17, and watchOS10
before we get stuck into the new updates and bring them to
Mac/Life. Until then, it’s business as usual, so what’s in store?

First up, we’ve got a complete guide to creating all kinds of
amazing documents in iWork, whether that’s using Pages —
Apple’s word processor — to help you commit words to “paper”;
making your data work better in spreadsheets with Numbers; and
creating brilliant presentations with Keynote. Check in here (p12)
if you want to know how to use any of those apps, and from there
how to do even more to make the most out of your documents.

If you have an iPhone and you count on it every day for a
variety of tasks, you could do a lot worse than read our cover
feature this issue (p52), which shows you all the features that
your device is capable of. Some of them you might not know
about, some of them you might — whichever way there are
plenty in there to keep you occupied for some time.

We’ve also got an in—depth guide to the Calendar app (@&1) and
while admittedly keeping tabs on your events schedule isn’t
exactly the most exciting thing to do in macOS, it’s arguably one
of the most crucial, so you’d be wise to follow this guide to ensure
you’re making the most of it. If you have any suggestions about
future content in Mac/Life, do get in touch with me. ®

W1

NICK ODANTZIS, Editor

Twitter: @maclife

EMAIL:[[etters@maclife.com
SHARE YOUR FACEBOOK:[facebook.com/maclitel

TWITTER:[fwitfer.com/maclite

Editor's opinion

© THE TEAM

Andrew Cottle

Art Editor

With his new iPhone 14, Andy
has been checking out the
hidden features on[p52]- and
is looking forward to casting
Harry Potter spells with Siri...

Rachel Terzian
Production Editor

With all the great new original
content being produced by
Apple TV+ (p6é), Rachel is
getting ever closer to
renewing her subscription..

Alex Blake

Contributor

One of our favorite things this
month is Alex's tutorial [p34),
which shows you how to find
your online search terms on
web pages you visit.
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Threads launches

Meta's Twitter-rival starts strong but has challenges

BY ALEX SUMMERSBY

THREADS, THE NEW social platform
from Meta, has become the fastest
growing app of all time — but faces
some issues. Threads became
available to the public on July 5, 2023,
and after just five days had 100 million
sign-ups. This eclipses ChatGPT, the
previous record holder, which took
two months to reach that mark. Even
so, Threads is still some way short of
Twitter’s estimated 237 million users
active daily.

The Threads app is available on
i0S and Android in more than 30
languages and 100 countries. Because
of privacy concerns, however, this
does not include any EU member
countries at present.

Meta, which also owns Instagram,
Facebook, and WhatsApp, astutely
launched Threads just as Twitter
users were disgruntled by the
imposition of limits on the number
of views allowed per day and the new
requirement to be logged in to view
tweets or profiles. There are also wider
concerns about staff cuts at Twitter
and what these mean for its future,
with recent service reliability
problems attributed to this cause.

Another likely factor in the
explosive growth of Threads is its
close integration with Instagram,
which has an estimated 2.35bn
monthly active users. You can use
the same account name and password,
and users with a verified Instagram
account are automatically verified
on Threads. You can even import your
entire list of followed accounts from
Instagram into Threads with one click.

Like Twitter, Threads delivers
a mainly text stream, with options

4 | SEP2023

jiho100x &

to upload photos and videos. You can
respond, repost, and quote posts, just
as on Twitter. It is even possible to
share posts from Threads directly to
Instagram Stories.

However, there is no option to filter
your Threads feed to view only posts
from accounts you follow — you get
whatever the algorithm chooses to
give you. There are no hashtags. And
Threads founder Adam Mosseri openly
says the platform’s algorithms will
not promote hard news or political
content: “We are definitely focusing
on kindness and making this a
friendly place,” he posted. Threads
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is ad—free for now, although a number
of big brands have accounts and are
active. All this, some say, makes
Threads dull and unengaging.

INTERACTION WITH CAVEATS
Of course, some of this might change
in time. Other possible future features
include support for editing posts,
translation of different languages, and
compatibility with ActivityPub, which
would make Threads interoperable
with other compatible apps and
potentially mean that interactions
could hop between different apps.
One thing unlikely to change is the
huge amount of personal data Threads
collects — everything from your
precise location and browsing history
to ethnicity, health and biometric
data, contacts info, and more. To be
fair, this is not a whole lot less than
Twitter and Instagram also collect,
but privacy advocates point out that



“a good amount of it is not
necessary for the app to function.”
For this reason, Threads is not
available in the EU, which has tight
controls on data privacy. The EU’s

Digital Markets Act, which comes

into force this year, entirely
prohibits the use of “sensitive
data” for targeting ads.

Even in the US, the linking
of Threads with your Instagram
account may be viewed by the FTC
as “unfair or deceptive” practice,
obscuring your control of your data
— particularly because, as the
Threads Supplemental Privacy
Policy reveals, although you can

pause your Threads profile at any
time, you can delete it only by
deleting your Instagram account.
After the initial spike, it looks
like Threads usage has dropped
back — users reportedly by 20% or
more, and time spent by as much
as 50%. One factor might be that,
to stay on the right side of EU law,
Meta blocked VPN access for users
in Europe, but it’s unclear how
many European users were taking
this route anyway. It may be simply
that after the intense initial
interest, users aren’t thrilled with
Threads and are using it less than
they might use other social apps.

> Mac soars while
PC market slumps

MORE THAN ONE in every five
computers in active use today is a Mac,
giving macOS the second largest share
of the global personal computer market,
according to StatCounter. Analyzing the
global web usage share of PC operating
systems between June 2022 and June
2023, StatCounter says macQOS has an
adoption rate of 21.4%, second only to
Windows, still dominant with 68.2%.

Chrome OS trailed with 4.2% and
Linux with 3.1%. As for mobile operating
systems in the same period,
StatCounter says iOS has an adoption
rate of 39% and Android 22.7%.

Usage share is a more revealing
indicator than sales, but macOS sales
too have risen, against the industry
trend. According to IDC, global PC
shipments declined 13.4% year over
year in the second quarter of 2023 —
the sixth consecutive quarter of
decline — but Mac shipments rose
10.3%. Canalys puts the PC market
decline at 11.5% but the Mac growth
at an astonishing 50.9% thanks to
strong demand for the new 15-inch
MacBook Air.

Both analytics firms rank Apple as

the fourth biggest vendor by shipments:

VENDOR 02
2023 SHARE A
pple
(CHANGE YOY) 8.6%
(+10.3%)
Dell
16.8%
' (-22.0%)

Source: IDC

Image rights: Apple Inc

HP

21.8%
(-0.8%)

Lenovo

23.1%
(-18.4%)

The latest news from the world of Apple

News in
brief

A bite of the Apple

> APPLE WATCH ULTRA 2023
PARTS TO BE 3D-PRINTED

A second-gen Apple Watch Ultra will
arrive later this year, with some
mechanical parts 3D-printed, claims
respected analyst Ming-Chi Kuo. The
model's mechanical parts — the digital
crown, side button, and action button
— are currently machined in titanium,
and the change could save both
production time and cost. If all goes
well, the analyst says, more Apple
products could adopt 3D printing
technology in the future.

> APPLE ROLLABLE SCREEN?
Foldable screens? So 2021. Apple’s
latest patent application is for a display
that can be rolled up. It's an idea Apple
has been exploring since 2014 and the
filing is long on concepts but short

on details, so don't hold your breath.

> APPLE LANDS RECORD 54

EMMY NOMINATIONS

Apple has scored a record number

of Emmy Award nominations — 54 by
Apple's count, including four ads made
for it. Apple TV+ global hit Ted Lasso,
with 21 nominations, is the most-
nominated comedy for the third year
running, and STILL: A Michael J. Fox
Movie is this year's most nominated
documentary film or docuseries, with
seven. The winners will be announced
on September 18, 2023.
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Apple TV+

and the battle of the streamers

Streaming is an exceptionally competitive area. We take a look at how Apple
TV+is holding its own in a tough market WRITTEN BY CHARLOTTE HENRY

I— n March 2019, Apple CEO

I Tim Cook took to the stage

to announce that Apple

|_ was entering into a whole
new business — video streaming. Not
only that, but its service would also
house only original content. With
Apple TV+ launching in November
that same year, Apple entered into the
business of making and buying
TV shows and movies. It is unlikely to
catch up to industry leaders like
Netflix in the foreseeable future, but
nearly four years on the company is
holding its own with that approach,
which is in contrast to that of its rivals
who have tended to build a catalog of
existing content before moving into
creating their own originals.

With many free limited-time deals
on offer, it’s difficult to get an
accurate figure on how many people
have access to Apple TV+, and

Apple TV+ became the first streaming service to
win an Oscar for Best Picture, for CODA.

6 | SEP 2023

numbers for how many people are
actually paying is even more vague.
However, we can see how the service
is working in terms of professional
criticism and popular acclaim.
Comedy series Ted Lasso was a major
success, picking up awards and a
devoted audience during its three—
season run. Apple TV+ was also the
first streamer to pick up a Best Picture
Oscar for drama film CODA,

a significant moment that Netflix had
been desperate to secure.

In many ways, the best competitor
to judge Apple TV+ against is Amazon
Prime Video. Like Apple’s offering,
Amazon’s service is from a tech
company whose key focus is not
acquiring streaming customers. For
many, the key is getting next-day,
free delivery, and the films and TV
shows included with a Prime
membership are simply an
added bonus. In the case of Apple,
customers buy a new device that
comes with a free TV+ trial and they
are introduced to the service that way.
What Apple really cares about is you
buying a new Mac or iPhone. Digital
consultant and media commentator
Nic Newman gives us his opinion:
“Apple (like Amazon) has been able to
leverage its wider product portfolio to
build an audience for Apple TV+. A

large number of people who buy
iPhones and Macs get free Apple TV+
and they have also worked with
mobile companies like EE to offer
longish trials or add-ons to phone
bundles. They also have their own
bundle (Apple One) and this approach
helps to reduce churn.”

It is worth remembering that Apple
TV+ was completely free for basically
everyone in the first year — a new
Mac or iPhone got you a year-long
trial — so we are still relatively early
on in the process of anyone being
asked to pay for it.

Francois Godard of media analysis
firm Enders Analysis believes that:
“Apple TV+ has proved to be a creative
hothouse, generating more Emmy
nominations than Amazon Prime
Video’s bigger operation. Silo is as
good as anything released recently
sci—fi wise.” But goes on to say: “The
problem is that Apple TV+ is the last
big [player] in a saturated market.
They have a subscription pivot
strategy where video would play the
engine, with a view of creating a
marketplace along the line of the
iPhone App Store. But others like
Amazon are way ahead doing exactly
this. To break through Apple would
need to double down, and do they
have the guts?” &

Image rights: Apple Inc.



The latest news from th

With a killer series like Hijack

in its portfolio, Apple has more
chance of retaining paying
subscribers and, as importantly,
attracting new customers.

WEY'RE IN CONTRO LS

IDR\S ELBA

H/JACK
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PREHISTORIC

o Essentially, while iPhone
and Mac sales will always be
fundamental, Apple wants
TV+ to be a desirable service
in and of itself and wants it to help
drive sales of other services too.

This is part of a wider emphasis

from the company on services
revenue in recent years. Having
high-profile content serves as
another way of drawing people into
the Apple ecosystem.

Apple has used its vast resources to
break in to a highly competitive
market and is undoubtedly beating
out smaller and later arrivals like
Paramount+. It has made a creative
impact and is undercutting some of
the already well-established
streaming services on price. If paid
for individually, Apple TV+ still only

What to watch

Shrinking

From the team behind Ted Lasso,
an uplifting, moving comedy about
a therapist recovering from his own
personal tragedy.

8 | SEP 2023
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Fans of the ecosystem are
more likely to buy an Apple
TV and in turn buy into
Apple TV+, but the content
has to be good enough
to keep them subscribi

costs $6.99, compared
to $19.99 for an
equivalent service on
Netflix or $8.99 for Amazon Prime
Video as a standalone service.

Apple TV+’s most difficult battle is
really against Disney+, which
launched at more or less the same
time and offers vastly more content.
It offers all the classic Disney films
and their modern reworkings, Pixar
movies, Star Wars, the Marvel
franchise, and National Geographic.
Ad-free streaming on Disney+ costs
$10.99, or $109.99 for the year.

THE NEXT GAME

Acquiring sports rights has become
the next game for streaming services.
Apple has been fairly proactive in this

APPLE WANTS TV+
TO BE A DESIRABLE

SERVICE IN AND OF
ITSELF, AND DRIVE
SALES OF OTHER
SERVICES

area, perhaps more so than many
would have expected. In March

2022, it announced that it would show
two Major League Baseball (MLB)
games every week in several
countries, alongside other baseball-
related content in the US.

In June last year, Apple and Major
League Soccer (MLS) announced a
staggering decade-long deal for Apple
TV+ to be the broadcaster for all
games. This was not included as part
of a standard Apple TV+ subscription
but as a bolt-on costing an extra
$12.99 per month or $79 for the
season. By contrast, at the time of
writing MLB Friday Night Baseball
does not cost anything extra.

Apple also got a huge win when it
was revealed that World Cup winner
Lionel Messi was heading to the MLS
to play for Inter Miami. The presence
of the Argentinian superstar makes a
Season Pass much more enticing for
many viewers. Indeed, there were
even reports that Messi was getting a
cut of the subscription revenue as part
of his deal.

Amazon Prime Video already shows
Premier League football in the UK at

Silo

Based on the Wool series of novels, Silois a
powerful sci-fi dystopian thriller in which
people search for the truth about their
strict underground life.

Super League: The

War for Football

A documentary covering the chaotic
four days in which the European Super
League was launched... and shut down.

Image rights: Apple Inc/Doozer Productions/Warner Bros TV, AMC Studios, All Rise Films.



various points in the season and a
Thursday night NFL match in the US.
Elsewhere in the US, Peacock shows
almost every Premier League football
match every weekend. Apple is not
quite competing at that level yet, but
it has certainly shown intent. Its
approach to sports rights, unlike the
other services mentioned, seems

to focus on making sure the matches
can be shown in as many territories
around the world as possible. This is
thought to be one of the reasons it
pulled out of negotiations to get the
rights to NFL Sunday Ticket, with
those going to YouTube TV. (This is a
general theme of Apple TV+, because
it is all originals, the content on offer
is consistent globally.)

As Godard of Enders Analysis
concludes: “Last year, Apple showed
that they were pretty picky in their
negotiations with the NFL. I don’t
think they could get a rights package
in Europe that would fill
their expectations of global coverage.”

Netflix has been the most reticent
of all the mainstream streamers about
getting into the live sports game. It
simply has not done it. Its non—
sporting forays into live broadcasting
have had mixed results. A live Chris
Rock comedy special was considered
successful. However, a reunion for
the reality show Love is Blind
was a disaster, with the live broadcast
not working at all and the show

Coming soon

The Morning Show

The newsroom-based drama returns,
with Jon Hamm (Mad Men) joining the
star-studded cast. The popular show's
third season starts September 13.

having to be made available to
stream shortly after. Many fans were
left disappointed.

The direction of travel seems pretty
clear though. As sport is one of the
only things that keeps a significant
chunk of people paying for their TV
bundles, it is likely to be a key driver
of streaming service revenue in the
future. We probably won’t see the
Game 7s of the World Series, the
Super Bowl, or the Champions
League Final on Apple TV+ any time
soon, but the service has made sure
that it is in the game from fairly
early on.

Away from sport there is plenty
more to come from Apple TV+. The
arrival of the film Killers of the Flower
Moon from Martin Scorsese and
starring Leonardo DiCaprio and Robert
De Niro is hotly anticipated. The
movie, which depicts the horrors
inflicted on the Osage Nation in the
US, is being released in cinemas
before it lands on Apple TV+. This
shows that Apple is increasingly
confident about people being able
to see its content away from its
service. It also means that the film
can compete for an Oscar, after the
Academy updated the rules and
expanded the theatrical release
demands placed on contenders.

Apple TV+ has always emphasized
quality over quantity. It still seems to
be holding strong with that approach,

Killers of the Flower Moon

The much-anticipated Martin Scorsese
movie covering the Osage murders finally
arrives this year. It releases in cinemas on
October 6; and on TV+ from October 20.

Image rights: Apple Inc, Echo Films/Hello Sunshine, Paramount Pictures, Aggregate Films.

The latest news from the world of Apple

even at a time of squeezed incomes
when people are more cautious about
spending money on extra
entertainment services. Given its
smaller catalog it is unlikely Apple
TV+ will ever be the “main” streaming
service people sign up to. However,
four years in, the presence of live
sport, popular shows, and big—name
movies is proving to be a strong
offering in a tough market. »

Lessons in Chemistry
Elizabeth Zott (Brie Larson) aspires to
be a scientist, butin a male-dominated
society she ends up presenting a
cooking TV show. Due October 13.
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> THE SHIFT

MATT BOLTON wonders whether the
collapse of the social web means it's
IMessage’s time to truly shine

TTHE MOMENT [ write
this, the social era of the
internet is in chaos.
Twitter has locked tweets
behind a login, Instagram is
known as a sales front rather than
social hub, Reddit has infuriated
and driven away the moderators
who keep it from descending into
Lord of the Flies, TikTok might get
literally banned, and Facebook’s
reputation is that it’s where people

THE SEMI-PRIVATE
SOCIAL WEB IS HERE,
WITH THE CHANCE TO
EXPAND THEM

use their real names and photos to
say the cruelest things. Upstarts
that aim to replace these sites have
been springing up all over, but
that’s exactly their problem — no

__ individual has the mass of people

- =D

Notabl

99 Foliowing  7.5M Followers

Tweets Media Likes

Tweets & Replies

Notable Account £ @hotableA
Thank you to all of my supportive fans.

You guys are simply the best.

As the CEOs of Twitter, Reddit and Instagram
continue their push to alienate droves of people,
where is left online?

or interest needed to be a
replacement for a truly social site.
Maybe Meta’s new Threads service
will, but given how negatively
people think of Instagram and
Facebook, Threads’ potential
success certainly hangs by a... well,
you get it. I mean, people still use
Facebook and Instagram in their
droves today, but that’s because
they have momentum — how
many of us would sign up today,
with full knowledge of what those
platforms are like now?

So what is next for online social
connections for adults? The kids
are ensconced in Fortnite, Roblox
and Discord as places to hang out,
but these are never going to appeal
to Uncle Geoffrey. Where will the
rest of us go for a place to connect
with friends? A lot of this has
already moved to texting groups
for people — especially
in WhatsApp, though Signal and
Telegram have been making moves
too — and it seems like that’s only
going to become more the case.
The semi-private social web is
here, with closer—knit groups than
traditional social media, but the
chance to expand them with
new invitees flexibly and easily.

This now leaves an opportunity
and/or conundrum for Apple.
iMessage is one of these services,
with lots of the same smart
features you get in WhatsApp
and so on. But whereas all these
other platforms are open to
everyone, iMessage is Apple only
— the potential to be a social
platform will always be limited by
being actively exclusionary. Up

°%

4 Paople

Hey! Have any of you ordered
dinner from the new restaurant
in town?

ia_. The pizza place?

&  [think Lauren has?

iMessage is all geared up for groups already, but
what if one person doesn’t have an iPhone?

until now, this has been massively
in Apple’s favor — among the
youth in the US in particular, you
can’t be seen to have green bubbles
instead of iMessage’s blue ones. So
iMessage directly pushes people

to buy iPhones. And it works;
iPhones dominate the US teen
phone use figures.

But now we’re entering a new
phase, where competing chat apps
might become a primary way of
being social in groups if they can
pull people in cross—platform. This
means that people will be more
inclined to use them for other
communication than now. So
Apple’s dilemma is: open iMessage
to Android at last and have the
chance to finally launch an actual
successful social venture, but lose
the exclusivity that’s been
powerful; or risk losing mind-
share to WhatsApp.

The answer is simple: a new
bubble color for everyone who uses
iMessage on Android. It’s really
that simple. Let others join the
chat. Problem solved!

>>> Matt is Managing Editor at Future's flagship technology website TechRadar and has been charting changes at Apple since
his student days. He's skeptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing.”
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LETTER OF THE MONTH

I would like to take issue with “Can’t

operate your scanner” (tip 14) in your
“Fast Fixes” feature (ML208). I have
a CanoScan 3200F. Image Capture
doesn’t recognize this scanner; it
doesn’t find the scanner. It is
USB-based and so should be
identified according to your
article, but it doesn’t... So it
would appear that the fix
is obviously dependent

on more than just
Image Capture!

One of the reasons I

need to access this

machine is down to Canon
refusing to release compatible
drivers for 64-bit systems, it

worked fine on my old PowerPC. I

have asked Canon to provide the
source code so I could recompile for
64-bit, but unfortunately this was

refused point blank.
DAVID RAMSAY

While Image Capture should work with
the overwhelming majority of scanners
released in the last few years, support
for older models will be limited. That
appears to be the case with your
CanoScan 3200F, which was originally

Oh no, Vimeo!
The TV market is booming, with
ever bigger, brighter screens
and sharper pictures, so why is
Vimeo now ending its range of
TV apps?

| complained last year when
Vimeo withdrew its Samsung
TV app. Vimeo said | could
continue to watch my videos
by getting an Apple TV, which
they were still supporting. So |
bought one. Now, however, |
have suddenly found | can no
longer access all my videos on

SHARE WITH US!

Apple TV. A message appeared
that Vimeo is pulling all
support for Apple TV.

What a disgusting way to
treat subscribers who have
been paying for their servicel
With such contempt for its
loyal customers, will Vimeo
soon be out of business? There
must be better video-hosting
services out there.

NIGEL WATSON

Vimeo has sadly removed
support for its app on Apple

EMAIL:[letters@maclife.com|

FACEBOOK:facebook.com/maclitd TWITTER:[Ewitter.com/maclitd

It's frustrating when we can't connect to older gear,
but there are usually plenty of apps that'll try to help.

launched some 20 years ago. To get
around the lack of support in current
versions of macOS, we suggest you try
VueScan (from $39.95,[RamricK.com)]
The app supports over 7,100 scanners
old and new, including the CanoScan
3200F, and works brilliantly — we’ve
owned a copy for decades and it’s
never failed us.

TV, but is doing the same on
Android TV, Amazon Fire TV
and Roku too. In a statement
on its website, Vimeo says:
“Occasionally, we retire
legacy products and
features that are no longer
consistent with our
standards. We believe that
our users looking to view
Vimeo videos will receive a
better ongoing experience
by casting via our mobile
app. enabling customers to
enjoy Vimeo content on their

| TV". In other words, you'll

need to stream Vimeo
videos from your
iPhone, iPad or
Mac to your TV
via AirPlay in
future.
While that
seems like an odd
decision, it is
perhaps an
understandable one
— having to support
multiple versions of an
app across different
platforms can be costly,

/ | technically challenging and

time-consuming for
developers, just look at the
Apple TV version of BBC
iPlayer. It still doesn’t
support subtitles, even
though the iPhone, iPad and
Mac versions do. The
reason? “There are technical
challenges associated with
delivering subtitles to Apple
TV, which will require a
significantly different
solution to that which we
use on all other platforms”.
Streaming via AirPlay using
an existing app, then, seems
like a good strategy to adopt.

Big Mac needed

When, oh when, will there be a
new 27-inch iMac, for
goodness sake?! How
frustrating that Apple releases
a 24-inch, but no murmuron a
higher spec'd 27-inch version?
Is it because they want to try
to get people into buying the
more expensive Mac Studio?
NICK HUGGINS

An iMac with a display "over
30 inches" in size may

be on the cards, according to
insider Mark Gurman.

Mac|Lifes®
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pple’s
A productivity
suite hascome a
long way.
Originally sold as a collection
called iWork, the three apps — a
word processor called Pages,
the Numbers spreadsheet
application, and Keynote for
presentations — are now
available separately,
and they're all free.
The iWork apps
are built with user-
friendliness in mind,
but not at the cost of
features. Pages, Numbers and
Keynote are likely to offer everything
you need, and right at your fingertips.
You can learn the basics of each app

Image rights: Apple Inc.

MASTERCLASS

AMAZING
DOCUMENTS

Create top-quality documents
with Apple’s brilliant iWork apps:
Pages, Numbers, and Keynote

Make amazing documents

WRITTEN BY IAN OSBORNE

in about half an hour, and expert
features are within easy reach too. As
well as using the iWork apps on your
Mac, iPad and iPhone, you can also log
on to the iCloud website
with your Apple account and access
web-based versions of the apps, even
picking up where you left off with a
document you saved earlier.

In this guide, we show you how to
get to grips with Pages, Numbers and
Keynote. Assuming no prior
knowledge, we teach you how to
create your first document. Taking
things further, we also bring you a
selection of pro tips to help you
get even more from your Apple
productivity apps. So what are
you waiting for? Let's see what
the suite can do.

SEP 2023 | 13
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Apple’s
word processor

ages offers a comprehensive set of

features. You can use it to create

stunning documents containing
charts, pictures, shapes, tables, and even
videos as well as text. You can flow text
around objects for that professional look.,
and there’s a huge range of templates to
choose from.

Use templates

When you open a new document from
the File menu or by pressing Cmd+N, you're
offered a choice of templates. If you want to

w— Chooss & Templats

- (E a-ag

= - = | B
N =g -5 nma
Pages has a wide range of templates, for a variety

of different types of document.

proceed without using a template, choose
one of the "blank" options. It's a good idea to
familiarize yourself with the templates.
Starting with one and changing its text and
graphics is much easier than starting from
scratch, and playing around with the
templates helps introduce you to what the
app can do.

Change the fonts

In the Pages right-hand sidebar,
click the Format button in the top-right
section of the toolbar for the text tools, then
click the Style tab. Use this to style your text.
The Font section uses pull-down menus to
change the font, choose from variations on
the font (usually Regular by default), and the
arrows let you change the point size. Or
double-click on the window showing the
point size and type itin.

Text color

In the Style tab, to change the text
color, highlight the text you want to change,
click the box marked Text Color and choose a

Use the Document sidebar

g0t a tattoo that says ‘Love All Animals ' Because that's e
how 1 feel.”

Dwes she wish she'd have waited until she was older befo
getting her first ink? “Not really,” she explained. “Becaus
spent so much time thinking about it before I went to the
tattonist, | was very sure about what [ wanted, where [
wanted it and how it should look. As a result, 1 stll like

it after ail these vears. You're right though.
Unfortunately, lot of people nash into getting a tat just
hecause they can and end up with something they
regret.”

lattoos at Work
With tatinos becoming more commaon everywhere,
they're no longer a problem at many workplaces, and
Della’s is no exception. Even sn, a5 she works as a
receptionist at a five-star hatel, 5o she has to cover
them up. T wear long-sleeved shins when at the
reception desk. T wish I could wear short-sleeved
blouses during the hat weather, but unfortunately,
that's too much ink for the job, My wrist tattoo often
peeps out below my cuffs, though, and no one really
minds about that.” 7

“People’s attitndes to tattoos are different nowadays.

My grandfather tells me in his day, it was only the

military and eriminals who had tartoos, and a woman

with ink was lkely to be in a circus, But these days,

everyone has them "

Is that a good thing or a bad thing? “It's mived news,”

says Defla. “Tt's great that tattoos are accepted and

there are dozens of tattoo studios in every town to choose

from, but too many people get clichéd, boring designs. 1 v

people would think before thiey ink. It wonld probably me

fewer people on the street would have them, but at least ¢
1 that did would have something worth looking at.

What does her family think of her tattoas? “My dad hates
them,” she says. He really doesn't like tattoos on women,
he aceepts it's my body and my decision. Mum says she li
them._andsnuld neahabi sat ane herself if my dad was

. cared of the needbe a

In the Style tab, you can change the color, size, them. bur thar's nox
. ' . =If, and his girlfriend

font, and justification of your text. You can also

make lists, add drop caps, and more.

wk ﬁ yourself? *2

new one. Alternatively, you can pick a
new color first, without highlighting text,
and type in that color. Click the color
wheel for more options. Select Text Color
and you can choose colors for gradient
and image fills too.

g B e ——
“lllll'|.|-.- l.
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Set size and print

First of all, click the Document icon
on the right-hand side of the toolbar. This
opens the Document sidebar. If you want to
print the document, use the Printer & Paper
Size pull-down menus to set the page size
and choose your printer.

14 | SEP 2023

Sidebar options

You can change between portrait and
landscape page orientation, and set header
and footer margins. You can also select
Facing Pages to set up two-page spreads
with the option of using different margins,
headers and footers per page.

i Adthag Commcta ermaniue

Mail Merge

Use Add Merge Field to add details
such as a name, address and more, which
is drawn from a database (your Contacts
app by default). Click the Merge button (top
of the sidebar) to choose a database, then
print the merged document.

Image rights: Apple Inc.
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Justification

Justification refers to whether the text
is aligned left, right, centrally, or both left and
right. The four buttons below the Text Color
section illustrate this — click one to set the
text that way. Also in this section, you can
increase or decrease the indent to make the
margins larger or smaller.

More tweaks

Spacing sets the space between lines.
Click the chevron in front of the Spacing
listing for more options. Turn highlighted text
into a list with Bullets & Lists. Again, click the
chevron for more options. Click the Drop Cap

t b4 B
%, his local railway e
as very ordinary,
k going from here to — -
ud emother taking
2 there to here, with S Loen TN
+ footbridge between A
orms. There were
ats on each side, .
3 one ever used as 1 A tazen
ad eight months of 5 b
they were freezi & B coburn wim
tking wet or both. wderes
weh forethought aBsemd pemt e

Under the Layout tab’s Columns option, you can
set a number of columns, decide how wide
they are, and set a gutter width.

Image rights: Apple Inc.
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Text can be wrapped around an object by using the
Format sidebar, and the Text Wrap pull-down menu.

checkbox to add a dropped capital, which
you can then modify to suit your needs.

6 The Layout tab
Also in the sidebar, there’s the Layout
tab, which is also for free-flowing text. Your
layout options include setting columns. You
can choose how many columns of text there
are, and customize their settings. You can
also set paragraph indents, set up tab
options, use borders on selected text, set
which edges of the selected text
they're applied to, and more.
7 Further formatting

Under the More tab, you can find
other options for formatting and stylizing
your text. Under Pagination & Breaks, you set
whether you want the app to automatically
prevent widow and orphan lines, start
paragraphs on a new page, and more.
Just tick the checkboxes of the options you
wish to activate.

Under Hyphenation & Ligatures, you can
set whether words can be hyphenated and
split across two lines, and whether to use
Ligatures, which lets certain characters
run together where appropriate for
easier reading.

The Document sidebar

In the top-right corner of a Pages
window, next to Format, you'll find a
Document option. Click this, then choose the
Document tab at the top of that sidebar. You
can now choose a local or networked printer
to print your document from, set the size of
headers, footers and margins, and more. In
the Section tab you can set background
colors, page numbers and more. The
Bookmarks tab lets you set and review
bookmarks — very useful for organization in
large documents.
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Text boxes

Text and picture boxes are an
important part of Pages documents.
To open a text box, click the button
marked Text in the toolbar. Click and
hold the box to drag it around on the
page, and resize it by clicking and
dragging one of the squares on the box's
border. Click on the text that's already in
the box and type to add your own text.

Make shapes

Working with shapes boxes are
similar. Click on Shapes in the toolbar, and
choose the one you want. As well as
regular shapes, they include arrows and
small drawings too, in a variety of
categories. Dragging a shape around the
document and resizing it with the
"handles" on its borders is done in the
same way as with a text box.

|

From the Shapes menu in the toolbar, you can
choose a shape to add to your document.

Sync with iCloud

Add color, borders,

and more
After adding a shape and positioning it as
you wish, click on it and change its style
using the options in the sidebar. Or you
can set it up to your preferences using
the options further down in this sidebar.
When you have it how you like it, if you
want to save this style for later use, click
the right-hand chevron in the Shape
Styles section and click the "blank” style
option showing a "+" sign.

Design with shapes

Click on a shape and you can
add text, which you can format by
clicking the Text tab atop the sidebar.
Alternatively, place a text box on top of
the shape if this works better. If you have
overlapping items such as shapes,
picture boxes, and text boxes on your
document, click the Arrange tab and you
can reorder them by bringing them
forwards or backwards in the stack, and
customize them with the options in the
sidebar. Make sure you click the object
you want to adjust first.

Use media

Click the Media option in the
toolbar and you can add a photo, video
or music to your document. From the
menu, select one of the top three options
for a media picker. Alternatively, select

Image Gallery and drag a picture onto the
box that appears, or select Choose

to navigate to the file you want to use

in the Finder.

Tables and charts

You can add tables and charts
to your Pages document too, and
populate them as needed. Try clicking
on Table in the toolbar for a mini
spreadsheet. Click the table then click
one of the circular icons in the top right
or bottom left to add or remove rows
and columns. Click Chart to add a chart,
and choose the color scheme and chart
type from the menu. When it's in place,
click on it, then select the Edit Chart Data
button to add data. Both tables and
charts can be dragged and resized
like pictures and boxes.

Text wrap

To place a picture of some sort
inside a piece of flowing text, drag it into
position, and while it's selected, in the
Format > Arrange sidebar, use the Text
Wrap pull-down to decide how the text
reacts to the item. Text can wrap around
the image, or run above or below it.
Alternatively, it can ignore it completely
and flow over it. If you go for this latter
option, remember how to move
overlapping objects forward and
backward in the stack.

Save to iCloud Drive

These tips work for all the iWork apps. If
you've already saved your document to
somewhere other than iCloud Drive, in the
File menu, choose Move To. From the
window that appears, choose Pages —
iCloud:; it should be offered by default.

16 | SEP 2023
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On other devices

Your document is now on iCloud
Drive. Open it on any Apple device signed in
using your Apple account; open Pages,
navigate to the "Pages - iCloud" folder in
your iCloud Drive and open the document
to carry on where you left off.

Using

You can also use Pages in a web
browser on any device. Go to[iCloud.coml
and sign in with your Apple ID. Open the
Pages app and navigate to the doc you
want in iCloud Drive. You can edit it in
the browser, saving your progress.

Image rights: Apple Inc.
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QUICK LOOK Pages at a glance

Make amazing documents

D
Left-hand sidebar

The left-hand sidebar can show thumbnails
of your document's pages. You can drag
page thumbnails into a new order.

Formatting
After adding text boxes to your document,
you can change their font, color, point size,
angle and more.

More Pro tips

4

Image rights: Apple Inc.

D

View options

Click the View icon for a window showing
these options, including showing/hiding the
word count.

Sidebar options
The object you have selected in

the document sets what options
are available in the sidebar.

]

The toolbar

From here, opt to add photos, shapes and
more, and switch between the Format/
Document right-hand sidebar.

]

Picture edits

Here we've clicked on a picture, and have
the Style tab selected. The other tabs
offer more options.

SEP 2023 | 17
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Numbers:
For awesome
spreadsheets

Get your numbers looking good — and making sense

ith Numbers, you can create
attractive spreadsheets quickly
and easily. Starting with a blank

page or one of the app’s excellent templates,
you can display your data in charts, tables,
images, Smart Categories and pivot tables,
making it easily accessible.

The table is the most basic Numbers document, but
it's still surprisingly powerful.

HOW TO Use Formulas

/I Templates in Numbers
There's an excellent range of

templates available for use in the Numbers
app. As well as blank documents in both light
and dark backgrounds, you can open
customizable ready-made spreadsheets for
budgets, savings, schedules, records, and
more. You're offered a choice of templates
whenever you launch a new document.

If you don't want to start with a template,
you can simply choose the Blank or

Black Blank option.

2 Using tables

The most basic Numbers
document is a table. This consists of
a grid of cells, into which you can type
information. Click on a cell to select it,
and then enter the data you wish to add.
You can format information added
to a cell in the same way you do

Date Artist
26th June The Street Band
3rd July Adrian Jones
3rd July Screaming Noise
3rd July Plastik Boytastik
¢ | 3rd July Prehistoric Man
10th July Humongous Death
¢ | 10th July The Boll Weevils

A Numbers document can include text and
media as well as charts and tables.

e Fetv oEgin.

Insert a formula

We want to add a column of figures
here, so click on the cell where you want
the total to be, and in the Insert menu,
choose Formula > Sum. The total of all the
quantities in the column are added, and the
total appears automatically.

18 | SEP 2023

Make a subtraction

To subtract fees incurred from this
total, click on the cell where you want the
total after fees to be, then in Insert >
Formula, choose New Formula. Click the

"Total Raised" cell, type the "-" sign and
click the "Fees" cell, then the check mark.

L

TR
13
I

3 Get a final figure

We now want to subtract a 10%
commission from this figure. Click the "Final
Amount” cell, then go to Insert > Formula >
New Formula. Click the cell showing "Total
After Fees" and to subtract 10%, type
*90/100. Click the check mark.

Image rights: Apple Inc.
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Table Options

Caption

Headers & Footer
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Rows 131
Columns a3l
Table Font Size A A
Table Outline
None @
Album Price
On the Street £10.99 i
Live in London £10.99 (== e
The Split Eardrum £12.99 9 Aternating Row Colour 5]
Plastik People £9.99 Row & Column Size
Out of the Cave £10.99 e gL
Width WEpt o Fit
The Graveyard Shift £12.99
Here Today, Gone Tomorrow £10.99
Action Stance £9.99

Bitter Hymns

Corner icons

Click on a table, and you see aniconin
each corner. In the top leftis a circle
containing another circle. Use this to drag
the table around on the document. In the
bottom-left and top-right corners are circles

with Pages text. Tap one of the letters
across the top of the table or numbers
down the side to select an entire row or
column, and you can then format all the
selected cells together.

; M showing parallel lines. Click on one of these
-— -:n =7 - i to add a row or column to the table.
s == The bottom-right icon shows a corner.

| == - ‘;‘ = Click and drag this to add or remove
i S i, columns and rows.

—— SE
E__ = o Create more
 — i rows/columns
i If you need to add a row or column inside the
table, hover over the number to the left of a

row or the letter above a column. Click the
chevron that appears next to it for a menu.
There are options for adding a row/column

Numbers charts can display data gleaned from
a table in a very visual way.

Image rights: Apple Inc.

Pivot tables

A pivot table takes its data from an
existing table, but displays it
differently. To create a pivot table, click
on the original table (highlighting
certain cells if you don't want the
entire table included), and in the
Organize menu, choose one of the
options from Create Pivot Table. You
then customize the pivot table using
the options in the sidebar.

Merge cells

If you want to merge cells, so
multiple cells are turned into one, first
highlight the cells you want to merge.
Hold the Cmd key and click on themin
turn, orjust click and drag across the
table. Then Ctrl-click the selected
cells, and choose Merge Cells from the
contextual menu. If you change your
mind, click on the now-merged cell,
bring up the menu and select
Unmerge Cells.

Sheets, tabs

& controls
If you want to add another sheet to
your document, click the "+" sign in the
top-left corner. This lets you add
another page to your spreadsheet.
Click the chevron on a tab for controls
such as Rename, Duplicate and more.

Moving rows

and columns
You can move and reorder columns
and rows by double-clicking and
holding on the number or letter
representing that row or column,
and then dragging it into a new
position on your table.

You can create a pivot table using an entire
table of data, or specific parts of that table.




above or below a row and before or aftera
column. You can also open the Format
sidebar, click the Table tab and then enter
how many rows or columns you need in
those fields.

Headers

and footers
Headers and footers are a line of cells on the
left, top and/or bottom of the table. When
you scroll a table, a Header or Footer line
does not scroll off the screen. This is very
useful when you're dealing with a large table
and need to be able to see a row/column’'s
title at all times.

To set up headers and footers, in the

Format sidebar and Table tab, use the menus
in the Headers & Footer section.

FOR A VISUAL REPRESENTATION OF YOUR

Checklists

You can use a Numbers table to make a
checklist. To turn a cell or cells into a
checkbox, in the Format sidebar, click the
Cell tab and in the Data Format pull-down
menu, select Checkbox. The cells display a
small gray box. Click on it to check and
uncheck that box.

7Table styles

Table Styles work a little like

Pages’ Paragraph Styles (see[pT7). Click on a
table and at the top of the Format sidebar’s
Table tab, choose from one of the pre-
prepared styles. You can also set up a table
yourself using the app’s formatting tools, and
save that style for future use by clicking the
"+" sign on the second page of styles.

DATA, YOU CAN ADD DIFFERENT TYPES
OF CHART TO YOUR SPREADSHEET

10th July Action Stance
17th July Tracey Roach
17th July The Flying Fish
24th July Various Artists

You can add shapes and media to a Numbers
document, and format them accordingly.

20
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Charts

For a helpful visual representation of
your data, you can add different types of
chart to your spreadsheet by clicking on the
Charticon in the toolbar, and selecting a
chart type from the range on offer. You can
then click on the Add Chart Data button and
select what data from the table you want to
importinto the chart.

To change this, click the chart and use
the Edit Data References button. It's a good
idea to open one of the Numbers templates
containing a chart and experiment with it to
familiarize yourself with how charts work.

9Adding media

and shapes

You can add media and shapes to Numbers
documents, just like you can in Pages. Just
click the relevant icon in the toolbar, and
choose a picture, video, music or shape.
These objects can be dragged around the
document, resized, rotated, masked, and
moved forwards or backwards in a

Image rights: Apple Inc.
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A TABLE SECONDARY
The table is the This section here
backbone of the is also a table, which

Numbers app. You can
have them display any
data you wish.

collates information
from the main table
on the right.

(£

CORNER ICONS
The corner icons
circled here are used
to move or modify
their table, as
discussed elsewhere.

SIDEBAR

You can select the
Format or Organize
sidebar; click a tab at
the top for controls
and options.

stack, in the same way as you do
with objects in Pages.

1 Input text

You can also add text boxes to your
Numbers documents. Click the Texticon in
the toolbar, drag the box to wherever you
want it and add your text. Your words can be
formatted in the Format > Text sidebar,
using the same tools as are offered by
the Pages app.

1 1 Using colors

Highlight a row, column or cell/group
of cells, and in the Format > Text sidebar, you
can change the color of the contents by
clicking on the colored box and choosing a

Image rights: Apple Inc.

new color. You can use the pull-down menu
to choose to add a gradient rather than a
solid color too. In the Format > Cell sidebar,
you can change the cells’ background color
in the Fill section.

II Rename a document

Click a document's name, and type
a new title into the Name field in the pop-up
menu that appears. You can also add colored
tags using this menu, and choose a place
where it is stored when you save it. Like
Pages, if you save itin iCloud Drive it's
accessible from any of your Apple devices,
and atfiCloud.com]Click the Locked
checkbox to prevent these entries being
changed accidentally.

1 Preferences

Open the Settings pane through
the Numbers menu, or by pressing Cmd-
comma. The General tab sets defaults for
future new documents. When you
next start a new document, they conform to
the parameters you set here (though you
can then edit them if you choose). You can
also set the author's name here, and the
default text size.

1 4Sort options
In the Organize sidebar, click the

Sort tab. You then have the option to "sort”
your data such as, for example, reordering a
table’s entries alphabetically according to a
set column.
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Keynote: Professional
presentations

Create engaging slideshows and animations

eynote was originally developed
K for Apple founder Steve Jobs to use

when giving presentations at
keynote events. It quickly became clear that
Apple had a great product that Mac users
would like too. In 2003 it was released to the
public, and it came t0 i0OS and iPad0S in
2010. Today it's free for anyone who buys a
new Mac or Apple mobile device.

1 Text formatting

Keynote shares its text formatting
features with Pages, so familiarize yourself
with the Pages tutorial earlier in this feature.
When working with text, click on the Format
icon to access the Format sidebar, and you
can click the Style tab and add borders, fills,
reflections and more. Using the Text tab, you
can change the font, point size, justification,
and so on.

A new document
When you open a new document,
you're offered a range of different templates

to choose from. As with Pages and Numbers,

these are a great way to familiarize yourself

Keynote preferences

Open the Settings panel from the
Keynote menu in the menu bar. Take a
look through them — there’s some great
customization options in there. The
Slideshow pane, for example, lets you
decide whether to scale a presentation to
fit the screen, change the way others can
interact with your presentations, and
require a password to exit a presentation.

Aspect Ratio
The default aspect ratio for a
Keynote presentation is a convenient 16:9,

After adding a slide to your presentation, you can change its appearance in the Slide Layout menu.

with the app. If you want to start fresh,
pick one of the basic templates,

which simply give you a presentation
with one slide, showing a little intro
text that can be modified, reformatted,
or deleted entirely.

the standard widescreen dimensions. If
you wish to change this to an old-school
4:3 ratio, as used by old fashioned
televisions, or to a custom ratio chosen by
yourself, click the Document icon in the
toolbar to open the Document sidebar,
and use the pull-down menu found in the
Slide Size section.

Apple Pencil

When using Keynote on your iPad,
you can use your Apple Pencil to write
text and create drawings. Alternatively,
you can use it instead of your finger for
scrolling and selecting objects. To switch
these behaviors on and off, open a
Keynote presentation on your iPad in Edit

Slide Layout

To change the layout of an individual
slide, click the slide (not an object or text on
the slide) and at the top of the Format
sidebar, there’s a Slide Layout option. Click it
for a window showing a range of slides.

You can set your slideshow’s aspect ratio
to 16:9, 4:3, or a size of your choice.

mode (tap Edit if this button is displayed).
Tap the ".." icon and select Settings. Scroll
down to the switches in the Apple Pencil
section, and turn them on and off
according to your wishes. These changes




How to Work with transitions

Make amazing documents

/I Using transitions

You can animate slides in the same
way you animate objects. Click on a
slide, and in the Animate sidebar, click
on "Add an Effect"; by default, there’'s no
animation. Choose an animation from
the menu that appears.

Preview animations

Hover over one of the effects and the
word Preview appears to its right. Click it to
see what this transition does as it gives
way to the next slide. After choosing, click
the Change button to swap it or Preview to
see itin action.

Customize effects

Many transition effects can be
customized with options in the sidebar.
Options might include changing the
duration of the effect, how long it takes to
activate, the direction from which it comes,
and more.

Choose one to change the slide in question
to that layout.

New slide

Ctrl-click on the left-hand sidebar (use
the View icon if itisn't there) and choose
New Slide from the menu. Alternatively, click
the Add Slide icon in the toolbar to choose
a new slide from the Slide Layout menu
mentioned earlier.

5 Change picture
In the bottom-right corner of the
placeholder pictures (on the slide when you

Use the Settings option to decide how your Apple
Pencil behaves while using Keynote.

hold for all your Keynote
presentations, but they don't affect
the way the Apple Pencil operates
in other apps.

open it) is a circular icon showing the photo
symbol. Click on it to open a window from
where you can navigate to the picture you
want to use and choose it. Alternatively,
simply drag the pic you want on to the
template picture.

Add new media

or shape
You can add new pictures, videos, music
clips and shapes to a Keynote document,
then resize and restyle them to suit your
needs, in exactly the same way as you do
with Pages and Numbers. Click on the Shape
or Media icon, then choose the preferred
option from the menu.

Edit Mask

Click on a picture and then in the Format
sidebar, click Edit Mask. A small window
showing a slider appears under the picture.
Slide it back and forth to zoom in and out of
the picture, which expands and contracts
behind the picture window. Doing this lets
you display only part of an image instead of

The Edit Mask feature, found in all the iWork
apps, lets you change how a picture is shown.

BRIl =

The iWork apps can intelligently remove a picture
or photograph’s background.

all of it. To the left of the slider are Photo and
Crop icons. Click the Photo icon and you can
resize the picture itself using the squares on
its borders. Select the Crop icon and you can
do the same for the window in which the
picture sits.

8 Remove background

This is a new feature found in the latest
versions of all three of the iWork apps. To
remove the background from a picture, click
on the picture in question, and then in the
Format sidebar/Image tab, click Remove
Background. If part of the background is
missed, you can fine-tune things by clicking
and dragging with the picker. Click the Done
button when you're finished.

9 Rearrange slides

To change the order in which slides
appear, open the left-hand sidebar by
clicking View. The sidebar shows the slides
as thumbnails, in order. To reorder them,
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QUICK LOOK Keynote at a glance

(7]

The View sidebar

Click the View icon for this sidebar, showing
your slides in the order in which they appear
inthe presentation.

Slide Layout

Click here for a menu showing the
range of slide templates available.
Click on one to choose it.

# Do not boil it
# Choose a fresh bean
# Make sure all your

equipment is clean

# Use the correct quantity

of coffee

# Make sure it's brewed for

the correct length of time

# Make sure your filter is

new

The Play icon

If you want to see how your presentation
looks so far, click this icon for a preview of
the show.

(€]

Aslide

Slides can show headlines, text,
pictures, backgrounds, charts,
shapes, tables, and much more.

c

The sidebars

Keynote has three sidebars; Format,
Animate, and Document. Click these icons to
switch between them.

Edit Slide Layout
Click here to edit the "blank” slides shownin

the Slide Layout menu. Click Done when
you're finished.

simply click and drag the slide you wish to
move into a new place.

1 Play your slideshow
While you're building your

presentation, you can review what you have

so far by pressing the Play icon in the toolbar.

Add an animation, set it up with the animation
options, and test it using the Preview button.

24 | SEP 2023

The slideshow plays out, showing the slides
in order, using the animations and transitions
you've chosen. Click the "X" icon to stop the
preview of your presentation.

1 1 Animating text

and media
Instead of having the complete slide
appear with everything already in place,
you can have text and/or media arrive
and leave with an animation. Click on
the object (media, shape or text box) you
wish to animate and select the Animate
icon in the toolbar to open the
Animate sidebar. You see three tabs:
Build In, Action, and Build Out. Build In
animates the object as it arrives on the

screen, Action offers an animation while it's
there, and Build Out takes it away with

an animation. Click one of these tabs

and choose Add An Effect to select one
from a menu.

1 Animation options
Each animation offers a range

of options. For example, if an object is to Spin

into place, you can choose which direction it

arrives from, how long the animation lasts,

and whether it bounces into place. When

you've set the animation, click on the

Preview button at the top of the sidebar

to show how it will look in your

presentation. Click the Change button

to change your animation.

Image rights: Apple Inc.



How to Use Keynote on mobile devices

On the iPad

You can use your iPad to create and
edit Keynote presentations. You can also
use your iPad as a Keynote remote when
delivering your presentation. Tap the
iPhone icon in the top bar and follow
the on-screen instructions.

Layout Options

Currant
MNext

Current and Next

Notes Only

On aniPhone

You can create and edit
presentations on an iPhone too, if you
don’'t mind the small screen. It makes
a great remote, though. Pair it with
your iPad or Mac, and you can use
it to show your presentation.

Make amazing documents

Keynote

P

Slide 2 of 7

3 On Apple Watch

There's also a Keynote app for
Apple Watch. Set up your iPhone as a
remote and open the Keynote app on
your Apple Watch. You can then use
your watch as a wrist-mounted slide
clicker for your presentation.

1 Build order
In the Animate sidebar, there's a

button found at the bottom called Build
Order. Click it and a small window appears.
Here you can reorder your animations by
dragging and dropping, changing the order
in which they appear, animate while in place
and/or disappear.

With the pull-down menu, you can
choose whether an animation starts when
the previous one ends (with a delay you can

set too), or when you make a click with your
chosen device during the presentation.

1 Presentation devices
You can use your Mac's spacebar or
mouse button as a clicker in a Keynote
presentation. You can also use other Apple
devices, or a dedicated Keynote Remote.
These are handheld devices with controls for
clicking forwards and backwards through

| apresentation, and some offer a laser

Tips common to all iWork apps

Here are a few more handy hints that are applicable for

Pages, Numbers and Keynote.

1 Apple Pencil

pointer so you can point to key features
in your slides.

1 Charts and tables

You can add charts and tables
to your Keynote slides, and animate
them just like you do with media and text.
They can be very effective when used
sparingly, but too many facts and figures
aren't particularly exciting when it comes to

| creating an engaging presentation.

Continuity Camera feature. Click the Media iconin a

document’s toolbar, and at the foot of the menu are
options for taking photos, scanning documents, or adding
a sketch from mobile devices.

If you're using iWork apps on your iPad, you can use

your Apple Pencil with Pages, Numbers and Keynote.

2 Sharing

Click the Share icon to send a copy to another person,
or invite them to collaborate on your document. You can
use this menu to set who can access the document,
whether they can make alterations, and whether people
you send it to can also invite others to collaborate.

Continuity Camera

You can import a photo or video directly into Pages,
Numbers and Keynote from your iPhone or iPad, using the

Image rights: Apple Inc.

Set password

To set a password for an iWork document, inits
application’s File menu, choose the Set Password option.

that password.

You can then choose a password and set a hintin case you
forget it. That document can then only be opened with

5 Export to other formats

With an iWork document open, click on the File menu
in the top bar, scroll down to Export To and in a sub-menu,

you can choose to save it out as a PDF, an MS Office
format, for older versions of iWork, and more.
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HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

Master Quick Actions

Make your Mac life even easier with the power of Actions

REQUIRES
macO0S 12 or later

macO0S IS FULL of useful

things, but it’s not always

obvious where they are.

For example, one of the really
cool features in Finder is tucked away in
the Ctrl-click menu under Quick Actions.
Here you’ll find automations to turn
photos into PDFs, to open PDFs in
Markup mode and to change photos
from one format to another, and you
can also add your own.

Creating automations used to be the job
of Automator, which was brilliant but pretty
intimidating to newcomers. The Shortcuts
app, introduced in macOS Monterey, is
much friendlier - but, as we’ll discover,
it’s still more than capable of doing some
clever and useful things.

Quick Actions are a great way to
automate everyday things. You can use
one to automatically crop and resize your

YOU WILL LEARN
How to add useful
Actions to Finder

IT WILL TAKE
15 minutes

HOW TO Create a Quick Action

photos, for example. In this tutorial,
we’ll create one that automatically joins
multiple images together. We’re sure
you’ll have your own ideas, so get
experimenting and let us know what
you come up with. CARRIE MARSHALL

In here you'll find any Shortcuts you've created, otherwise
click on Gallery to find pre-made Shortcuts you can use.

O’ Rotate Left
[ Create PDF
@ Convert Image

EA Remove Background

Customise...

.

Find in Finder

In Finder, Ctrl-click on any file and
look for the Quick Actions option. Click on
it to see a list of available Actions for that
file (or none, depending on the file type).
Here we've Ctrl-clicked on a photo; the
actions do exactly what you'd expect.
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Start a Shortcut

You can create very complex
Actions in the Automator app, but
Shortcuts is much friendlier. Open
Shortcuts and create a new shortcut.
You should see this window, with a
sidebar of suggestions on the right.

fo» & C
q
Categories Apps
- T e Lontal
B Music N News
Notes B sumbes
m Overcast L) Paues
& Phowos @ Padcasts
# Create Photo Album
& Find Photos

Click on Apps in the sidebar and
choose the app you want to use in your
Action. Let's use Photos to combine
some images together. Click on Photos
and then look for the Select Photos option.
Double-click to add it.

Image rights: Apple Inc.
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Add more images

This is your Action’s input, where
it's getting its data or files from. In this
case we're processing photos and, in order
to have multiple photos selected, we need
to enable that by clicking on Show More
and ticking Select Multiple.

e} _—
W teksen

s e &
[ PR —

ey 3

_'i S Dl o e 0 B ]

Save your results

We've set the input and specified
the activity; we need to tell Shortcuts what
to do with the result - ie, to “Save to Photo
Album”. Use the search box to find that
and double-click; you can change the
destination from Recents if you wish.

[

i

Open the app

Open Photos and navigate to
your Recents folder. It may take a few
seconds for your library to update, but
if your shortcut has worked you should
now have your newly combined image
as the most recent addition in Recents.

Image rights: Apple Inc.

How to do anything on your Mac, iPhone & iPad

LE ok P i

Add an instruction
Now we want to combine our
selected images together. The fastest way
to find that command is to type “combine”
in the search box; the one we want is
Combine Images, so double-click on
that one in the sidebar to add it.

Test your action

Press the Play icon at the top of
the screen to test-run your Action. If
it's working you should now see the
Photos library window, and you should
be able to select multiple images. Do
that and then click on Add.

® o e [5) combine pics

@ select photos
include: Choose Al
Select Multiple: 8
m Combine # Phatos  Horizontally

Spacng 3

& Sove [ Combined image to Rocents

Name your shortcut

If the shortcut works, it's time to
give it a name. This should be descriptive,
as it's the name that'll appear in Quick
Actions when you've finished. Simply
double-click the name at the top of the
window and type the new one.

Add some space

By default, your photos will be
stitched together seamlessly. If you want
to combine your photos while leaving a bit
of space between them you can specify
that by clicking Show More and entering
a number in the Spacing field.

See the results

After a moment, you should see
the result of your Action - three separate
images stitched together - in the main
editing window. We need to check whether
the shortcut added the combined image
to the Recents album in Photos.

G » & 0

Details Privacy Setup

Pin in Marw Bar
Shon in Shara Sheat
FRaceive What's Onsersan

8 Use as Quick Action
& Findar ‘
& Sarvices Marw

Provide Output 7
Add Keyboard Sharteut |

Appie Watch
Show on Apple Watch

Add it to Actions

Click on the Info icon (top right of
the window) to see options including “Pin
in Menu Bar”, “Show in Share Sheet” and
so on. We want “Use as Quick Action” so
we can bring it up quickly in Finder, so tick
that before closing Shortcuts.
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Manage your
email like a pro
with Outlook

Outlook is now free for all Mac users.
Here's how to get the most from it
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REQUIRES
QOutlook for Mac,
macO0S 11 or later

YOU WILL LEARN
How to use Outlook for Mac
to manage your email

IT WILL TAKE
20 minutes

MICROSOFT'S OUTLOOK HAS had
something of a checkered history
on the Mac. At various times it’s
been a useful option for business
users who rely on Microsoft’s Office suite,
a reasonable alternative to Apple’s Mail,
and an application that felt like the very
poor relation of its Windows version and
was best avoided. Since its overhaul a few
years ago, however, it’s been a serious
contender for the best email application
for both business and personal use. And
that position was bolstered earlier this year
when Microsoft announced Outlook for Mac

QUICK LOOK Outlook’s interface

HL, s I i frum Hog Bay Saltwars. T

could be downloaded and used completely
free of charge and would no longer need
an Office 365 subscription.

There’s a great deal to like about Outlook,
not least that it looks and feels like a Mac
app and adopts many macOS features like
Handoff, Widgets, and integration with
Notification Center. Then there’s the option
to create profiles for, say, business and
personal email accounts, the automatic
filtering of incoming messages into Focused
and Other inboxes, and the ability to save
searches as smart folders. Let’s get started.
KENNY HEMPHILL

D

FILTERS

Incoming mail is filtered
into Focused and Other
inboxes, allowing you

to quickly see the most
important new messages.

MY DAY

The sidebar can display
upcoming appointments,
an agenda for the day, or
Outlook’s newest features.
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SAVED SEARCHES
You can save searches
you make often as

a smart folder, allowing
you to easily find up-

1 to-date results.

Q-

Wow o n

LMER train 1o
Edinurgh

w0 ;ﬁm;?‘;?um I o
= PINTO TOP
Incoming messages
you don't want to forget
about can be pinned to
the top of the inbox.
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How to do anything on your Mac, iPhone & iPad

HOW TO Set up and use Outlook for Mac

Lr IEEOVS

Itgatt ‘Welcome to Outiook
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Enser your emad address
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Add an account

Once you've downloaded and
installed Outlook, click on the Outlook
menu; choose Settings, then Accounts.
Click the “+" (at the bottom) and choose
New Account. Type the email address
and click Continue.
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o Manage profiles

Go to Outlook > Settings >
Profiles. Click on the profile you want to
alter, and choose from the Theme, Icon,
Appearance and Notifications options.
You can also change the name and the
email addresses that apply to the profile.

Manage calendars
Click on the sidebar button at
the top right of the window to view your

various calendars. Click the “." to choose
between Calendar view and Agenda. To
choose which calendars are displayed,
click the Settings icon.

Image rights: Apple Inc, Microsoft Corp.
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Finish account

Once you've typed in the email
address, Outlook will determine the type
of account and ask for details it needs.
You'll need to generate an app-specific

password on |https:/appleid.apple.co
for iCloud email accounts.
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Save a search

Type some criteria in one or
more of the search options, and click
the filter button at the right to refine
the search. Once happy with the terms,
click Save Search. Type a name for the
search in the folder when it appears.
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L] Matifications and Sounds

For new messages: Display an slert on my desktop

Bounce Outioni can In Deskiop
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Evant Remindes Style. Drutiock Buft-in ]
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Use notifications

Go to System Settings >
Notifications > Microsoft Outlook and
enable notifications. In Outlook, go to
Outlook > Settings > Notifications and
Sounds, and choose macOS Notification
Center from Event Reminder Style.

Stay organised with profiles

“Organise your work, personal or school accounts. You can
set different themes and notification preferences for each

profile.
Suggested
& work ® Scheol C
# Family ] 4 Finance o

Create a profile

If you use Outlook with multiple
email addresses, create a profile for
each by clicking the globe icon at the
top right, then choosing the type of
profiles you want to add. Click Next
and follow the on-screen instructions.

L ] Search Show Al O

Search Rosults: (@ Show top results
Inchude Dedeted Rams

*
Marrow your results by sslecting where you want to search:
All Makhoues.
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ssarching Unitisd Inbox,

Current Foider
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Saved Ssarches: () Show Sawed Searches fokders

Customize search

You can choose whether the
search tool looks through everywhere,
the current mailbox, or the current
folder. Click the Outlook menu, then
Settings and Search. Choose from
the options for narrowing the search.
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Customize toolbar

Click on the “." in the toolbar
and choose Customize Toolbar. Drag
elements you want to add to the toolbar
into the row at the very top of the
window. To remove items, drag them
off the top row and drop them.
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‘Sat List- Ed Shaaran's Mathamatics Tour
Apple Music g

Discover live music near you

Find out who's playing and where with help from Apple Music and Maps

REQUIRES
Apple Music and Apple Maps

YOU WILL LEARN
How to find music guides
and set lists for your
favorite artists and venues

IT WILL TAKE
10 minutes

who’s playing at your local

music hotspot, or seeing when

one of your favorite artists is on
tour, Apple Music and Apple Maps can help
— thanks to some new features in macOS
Ventura 13.4, i0S 16.5 and iPadOS 16.5.

Apple Music now comes with Set Lists,

which are curated playlists of songs of
currently touring artists, with links to
venues and dates on their current tour.
And Apple Maps contains Apple Music
Guides (currently 44 in total), showcasing

HOW TO Find set lists, music guides and more

WHETHER YOU FANCY finding out

music genres and venues in major cities
around the world, with links to relevant
playlists, venue information and links to
upcoming concerts. Both are a great way
to find out what’s happening near you.

At the moment, these new features are
somewhat hidden in both apps, suggesting
that Apple is trialing them ahead of the
next major OS updates for Mac, iPhone and
iPad, when they’ll hopefully become more
prominent. But let’s see what these
additions offer for music fans now.

ROB MEAD-GREEN
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Find artists

Open the Music app on your Mac
and type “set list" into the Search field at
the top of the left-hand sidebar. You
should see some results straight away. Or,
click Browse in the sidebar, press Return,
then select the Apple Music tab top right.
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See all the set lists

You'll see some of the available set
lists under Top Results at the top of the
main window, but to see more scroll down
to Playlists for more. To see them all, scroll
down to Categories, then click the Set
Lists entry that is shown there.

Have a browse

In the Set Lists category, you will
see a list of some of the artists who are
currently touring. Scroll down to see them
all. Click a set list under an artist's name to
see a playlist of tracks or click Browse
Upcoming Shows below that.

Image rights: Apple Inc.
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A set list on Apple Music is simply
a playlist of songs by a particular artist,
rather than being a collection of live
performances from their current tour.
Still, click “+Add" at the top of a selected
playlist to add it to your Music library.
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Add date to Calendar

Safari will download an .ics file
containing info about the gig to Finder >
Downloads. Double-clicking the file will
add that info to the relevant date in your
Mac's Calendar app. Add the date to an
existing calendar or create a new one.

£17) Find music guides

. Now let’s try Maps. Open the Maps
app and type “Apple Music” into the Search
field at the top of the left-hand sidebar.
Next, click the Guides button that appears
below the “Apple Music - Discover live
music” entry.

Image rights: Apple Inc
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See tour dates

Go back to step 3, but this time
click Browse Upcoming Shows to see a list
of concerts that artist is due to play. Safari
will open to a web page showing the
relevant info from Shazam. Hover the
pointer over a tour date for more info.

e —

@ casnearan
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"-) See venue details

Go back to the View Concert web

page in Safari, but this time click View
Location. Doing so takes you to the
venue's entry in the Maps app. enabling
you to find out more about it. You can
use this to get driving directions too.

Choose music guide

An Apple Music pane will appear,
containing over 40 music guides. Click the
All Guides drop-down menu to narrow
your search to a specific city — only nine
are currently listed, but that's sure to
change as the number of entries grows.

[, Foprosmis

Gat Ready for the Show
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View concert details
A View Concert button should now
appear. Click it to be taken to the relevant
concert web page. Here you'll find more
info about the show, relevant playlists
and more. To add the tour date to your
calendar, click "Add to Calendar”.

Get tickets from:
& Ticketmaster

el More into trom Bardsintown

Buy gig tickets

To purchase tickets for a concert,
go back to the View Concert web page

in Safari, but this time click the Tickets
button. Next, choose an option from the
“Get tickets from:" option that's displayed
— either Ticketmaster or Bandsintown.

Explore a guide

Select a guide to find out more. In
it, you'll be able to see all of the relevant
venues in a given location, detailed info
about each venue, links to relevant Apple
Music playlists, and to upcoming concert
dates for the weeks and months ahead.
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Find anything on a web page

Use The Magic Highlighter to find online search terms fast

REQUIRES
The Magic Highlighter
($1.99), mac0S 10.14 or later

YOU WILL LEARN
How to use The Magic
Highlighter to emphasize
words on a web page

IT WILL TAKE
5 minutes

=

GENIUS TIP

It's so good that you
could end up ditching the
familiar Cmd+F shortcut.
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WHEN YOU USE A SEARCH

ENGINE, it’s easy enough to

find web pages that purport to

contain your search terms. But
actually locating those terms within the
page you’ve opened? That can be trickier,
and often has you desperately reaching for
the Cmd+F keyboard shortcut after a bunch
of fruitless scrolling. It’s extra hassle when
things really should be easier.

A perfectly pofsed stand.
And incradibly fast

The Magic Highlighter makes it easy to find your search
terms on a web page, and it can be tweaked and
customized as you need.

Cue The Magic Highlighter. This Safari
extension automatically highlights your
search terms on any page found through
search engines like Google, Bing and
DuckDuckGo, making it incredibly easy to
discover the content you’re after. It’s so
good that you could end up ditching the
familiar Cmd+F shortcut before too long.

CUSTOMIZATION AND EXTRAS

As well as being quick and easy to use, The
Magic Highlighter is also very customizable.
You can add and remove highlighted words
on the fly, change the color of the on-page
emphasis, and toggle highlighted words on
and off individually. The extension works
across macOS, iOS and iPadOS, making

its $1.99 price tag excellent value.

A recent update brought a string of
significant new features and improvements
to the extension. Among the changes were
extra keyboard shortcuts, filtering of noise
words like “what” and “is” so they don’t
clog your page, and much more. ALEX BLAKE

Image rights: Apple Inc, Herd Works Inc.
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HOW TO Use The Magic Highlighter
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Enable the app

Open Safari then, in its menu bar, click
Safari > Settings > Extensions and click The
Magic Highlighter in the sidebar. Tick the
checkbox on the left of the extension’s name,
then click “Always Allow on Every Website".
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The Magic Highlighter
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Big and bigger.
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Show or hide

Press Cmd+Shift+F or click The Magic
Highlighter's icon at the top of the Safari window
to see its settings. You will see all the words from
your search phrase - click each one to show or
hide it on the web page.

ane ¢ EI trrvsbas e
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Add or remove

Underneath the highlighted phrases in
the pop-up window, press “+” to add another
word or phrase (or press F while the menu is
open). You can also click an existing word and
press D to remove it from the highlight list.

Image rights: Apple Inc, Herd Works Inc
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Big and bigger.

See the results

Now go to a search engine and enter
a query. When you click a result, you'll see
your search terms automatically highlighted in
yellow on the page. Right now, the app doesn’t
highlight words on the search page itself.
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Search in quotes

If you search for a phrase in quote marks,
The Magic Highlighter will let you show or hide
this entire phrase on web pages. This can be
a handy way to save on clicks when enabling
or disabling highlighted results.

wee [ + 0 fredpiarr o
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Change the color

In the same menu at the top of the Safari
window, you can change the default color used
to highlight words. This is yellow by default, but
you can change it to green, blue, purple, red or
orange, if you prefer.

=

GENIUS TIP

While The Magic
Highlighter’s settings
menu is open in Safari, you
can press “A” to quickly
toggle all highlighted
phrases on or off.

~

GENIUS TIP

The app ignores filler words
like “and” automatically.
Open the app’s menu and
click the toggle at the
bottom to tweak the
ignored words list.
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Get it with SmartGym

Work out better with Al-made routines

REQUIRES
SmartGym (Free, offers
IAPs), i0S 12 or later

YOU WILL LEARN
How to log your workouts
and try new exercises
with SmartGym

IT WILL TAKE
10 minutes set-up,
plus workout time

TRACKING YOUR WORKOUTS isn’t
b always easy. Apple’s Workout
app doesn’t show exercises with
sets and reps, while logging your
gym work in an app like Notes is hardly
optimal. Fortunately, there’s a better
way in the form of SmartGym.
With this app, you can set your own
routines or use Al-designed workouts
made by SmartGym. Over time, it learns
and adjusts based on your sessions. Each
exercise features an animation and a
detailed explanation to help you do it
correctly, and you’ll see the number of reps,
sets and rest duration as you go along.
Everything can be linked to Apple Health
and you never miss out on closing your
rings. There’s also a great companion Apple
Watch app, so you don’t even need your
iPhone when you’re pumping iron.
SmartGym’s free version grants access to
two routines, 10 histories and two measures.
Subscriptions start at $6.99 a month, and
we’ll cover some of the premium features
in this tutorial. ALEX BLAKE

HOW TO Get fit with SmartGym

Weight and Cables

Barbell

Dumbbell

Hi-Lo Pulley Cable

Create From Scratch

Trust Us

Create For Muscles

Log your gear

! When you first load SmartGym, it
will ask you what equipment you will use,
either at home or in the gym. To update
your selection, tap the More tab, then
tap Available Equipment under the
Smart Trainer heading.
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, Create a workout

To start, tap the “+" in the top-right
corner. You'll have three choices: create

a workout from scratch; let the app’s
Smart Trainer make one for you; or specify
muscles you want to target and let

the Smart Trainer do the rest.

Triceps Kickback

Sets

1] 10
o 10
10

00:26

00:09:17

Exercises

@ Add Exercise
) Crab Toe
= ' ! ﬂ Touches

Squat Hold
Calf Raise

Start from scratch
Tap Create From Scratch. Enter
your workout name and goal, then tap Add
Exercise. Choose from the app’s extensive
workout library, enter details like reps and
rest time, then tap Save. Add as many
exercises as you like.




Options

Beginner

Muscle Endurance

Robo workout

Choose how many days a week you want
to do the workout. You can change your
experience level and exercise goal under
Options. When you're ready, tap Add
Workout for an Al-crafted plan.

8

00:53
00:25:56

, Log your reps
W Tap the reps or weight to edit
the exercise’s details. Once a set is done,

tap the number on the left to log it; the
rest timer will now begin. Once you've
finished the full set of reps, you can
start the next exercise.

Wednesday
size (Hypertrophy)

This workout was created b...

More detail
Summaries of your past workouts
are at the bottom of the History tab. Tap
one to see workout duration, your heart
rate, the exercises you did, and more.
Tap the key stats at the top for more
detailed charts and info.

" Now try tapping “+" then Trust Us.

Full Body Upper Body Lower Body

Abdominal

Tailor-made

L Finally, tap “+" then Create For
Muscles. You can pick full, upper or lower
body to choose different muscle groups
(tap a muscle region to add or remove

it). Specify workout goals and duration,
then tap Add Workout.

Routine A1
More  Archive Remove

, Clone a routine

Back on the Routines tab, you'll
see a list of all your active routines.
Swipe right to left on one to archive

or remove it. Tap More to duplicate the
routine - this lets you create a similar
plan without having to start over.

7 Minute Workout (Home)

, Explore more

Tap the Explore tab. This contains
a huge number of exercises covering
different abilities and goals, as well as
workouts made for specific sports and
activities. You'll need a subscription to
access everything.

Crunch with Legs
on Bench

Sets

Pump some iron

= Now it's time to start working
out. Under All Routines, pick one of your
created routines and tap Start. You'll
now see the first exercise with the
number of reps required. Animations

at the top guide your form.

Workout history

Tap the History tab to view your
progress over time. You can swipe through
the graphs to see when you worked out,
your average heart rate, active calories,
and workout duration. Tap Monthly
Summary for stats.

Body Measures

73kg
181cm
15.90%

Measure up

The Measures tab lets you enter
various stats and measurements about
yourself that can be tracked over time in
SmartGym. You can import some data
from Apple Health, while other figures
will need to be entered manually.
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Play music using LockPod

Use a widget to control musical playback even when your iPhone is locked

Dance
Spotify

Driving tunes
Spotify

Focus Piano
Focus Piano

Summer party
Spotify

REQUIRES
LockPod (Free, offers IAPs),
i0S 16 or later

YOU WILL LEARN
How to add musical Lock
Screen widgets to i0S

IT WILL TAKE
5 minutes

—

GENIUS TIP

It just takes a few quick
taps to create your first
widget and load it on to

your Lock Screen.
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WHEN iOS 16 DEBUTED, it
introduced a feature that let you
add widgets to your device’s Lock
Screen. But if you want to add
anything more than a Now Playing widget
for your music, you’re pretty stumped.
Stumped, that is, unless you use LockPod.
This handy little app lets you add your
favorite tracks to your Lock Screen, whether

Apple Music >
e Spotify >

NOT SEEING YOUR PLATFORM?

LockPod lets you pick tracks from Apple Music and Spotify
at the moment, but could add more services in due course.

that’s in the form of playlists, albums, radio
stations or local content stored on your
device. Getting started is extremely easy,
and it just takes a few quick taps to create
your first widget and load it on to your
Lock Screen. Right now, LockPod works
with Apple Music and Spotify, although the
developer says more services could be on
the way. Apple Music has a few more
options inside the app, but we will cover
both options here. Whichever service you
use, you’ll end up with a much more
musically functional Lock Screen as a result.
LockPod is free to download and use,
but it also has an optional premium version.
This lets you add custom text and images
to each of your widgets and removes the
cap on the number of widgets you can
create (the free version is limited to one
widget). It’s not a subscription, though,
and you can pay what you want from
a choice of different price options.
Now that you’re ready, let’s dive in and
liven up your Lock Screen. ALEX BLAKE

Image rights: Apple Inc, Vedant Apps.
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HOW TO Put music on your Lock Screen (3]

JARGON BUSTER

My Widgets

Get started

When you first open LockPod, you'll be
able to choose between Apple Music and Spotify.
Once the app is connected to your chosen
service, tap the large blank box on the My
Widgets page to create your first widget.

New Widget

https://open.spotify.com/playlist/37i9dQ...

How do | find the Spotify URL?

PERSONALIZATION

Custom Symbol Select Symbol

Spotify

Spotify asks you to get the link for your
chosen album or playlist. In Spotify, find the item
to import and tap the “." button, then Share >
Copy Link. Back in LockPod, paste this link into
the Spotify URL box.

© ADD WIDGETS

@ LockPod X

Lock Screen editing

Lock your iPhone, then tap and hold on
its Lock Screen. Swipe to the screen you want to
edit and tap Customize, then tap the Lock Screen
on the left. Tap the widget box under the time to
add some LockPod widgets.

Image rights: Apple Inc, Vedant Apps.

You can add widgets to your

Lock Screen from i0S 16
Driving music onwards. These show info
and let you interact with
apps even when your
device is locked.

Music Library

Peaceful sleep
Music Library

Apple Music

If you're using Apple Music, tap Widget
Content to tell LockPod whether you'll be picking
a playlist, radio station, album or local library item.
Below that, you can choose the specific content

for the widget.
Custom Symbol Select Symbol
Custom Image Select Image
Focus Piano

WIDGET PREVIEW

Widget Style Preview Rectangular ¢

Start customizing

If you've paid for LockPod, you can give
your widget a custom name, icon and image.
Below this, you can choose to use a circular or
rectangular widget and see a preview (for free).
When you're done, tap Add Widget.

Rectangular Widget X
@ ctang g -
GENIUS TIP
Q Search
If you use Apple
Focus Piano ", Music, LockPod can show
your currently playing track
Rock inside the app. Just tap the
banner at the bottom
Dance & disco to control playback.
Place the widget

Select LockPod from the list, then pick
either the rectangular or circular shape. Now tap
the widget you just placed and tap the name of
the widget you want to load onto your Lock
Screen. Tap Done when you're finished.
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Remove objects from photos

This app’s content-aware Erase tool quickly cleans up your snaps

REQUIRES
Imgmi (Free, offers IAPs),
iPad0$ 15 or later

YOU WILL LEARN
How to use Imgmi's
content-aware Erase tool
to remove content

from photos

IT WILL TAKE
10 minutes

THERE ARE A PLETHORA of

image-editing apps on the

App Store that claim to use

some form of Al to enhance
your images, but the tricky-to-pronounce
Imgmi has a bit of a pedigree, as it comes
from Skylum, maker of the Luminar suite
for the Mac that has used neural network
smarts for a while now.

Imgmi has a few neat tricks for improving
images you’ve taken on your iPhone or
otherwise added to your camera roll. It can
replace the sky in a photo in a way that’s
almost seamless, turning a rainy day to

QUICK LOOK The Imgmi interface

a sunny one, or noon into sunset. There’s
the ability to remove powerlines from

an image, if parallel lines over the sky
are ruining your landscape photography,
and it has some tools to improve (or at
least change) the faces and bodies of your
portrait subjects. The app is free, but

you can subscribe for more features.

It’s the Erase tool that we’re going to
concentrate on here, however. This acts very
much like the Magic Eraser you might have
seen in the Google Photos app, allowing you
to draw over objects to make them vanish.
Here’s how it works. IAN EVENDEN

Remove Powerlines

Enhance™’

Skin™

Filters

Adjust

YOUR IMAGE

The image you're working on is
always at the top, and you can
pinch to zoom and two-finger
drag to move it.

40 | SEP 2023

NEW PHOTO

Click the “+" button to open the file
browser and select a new image to

work on from your Photos library.

ERASE TOOL

Tap here to open Imgmi's Erase
tool, and start brushing away
any unwanted objects in your
chosen photo.

SHARE

You can save your edited image
back to the Photos app from here,
or share it straight to social media.

Image rights: Apple Inc, Skylum Software.
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HOW TO Remove objects in Imgmi

Import an image
Getting your image into Imgmi can
be tricky if you've not taken the photo with
your iPhone or iPad camera. On opening
the app. it offers the Recents album from
the Photos app. with the option to switch
to others such as Selfies.

Google workaround

One way we found to get non-
Photos images into the Recents album
was to add them to the Google Photos app
first, then download them to the device.
You can't open images directly in Imgmi
from the Files app, unfortunately.

Find the tool

Immgmi opens an image in the
Sky Replacement tool. To change this,
pop up the Tools menu that's almost
hidden at the bottom of the interface.
A tap on this slides up some options,
with Erase at the bottom right.

Start erasing

The tool is a simple one, requiring
you only to drag your finger over the object
you want to remove, then let go. Note
though, that unlike Google's Magic Eraser,
you need to completely cover the
interloper rather than circle it.

Adjust the brush size

Additional precision can be
achieved using the slider at the bottom
of the interface to change the brush size.
You can slide it all the way right for filling
in large areas, and pull it to the left for
detailed masking.

Image rights: Apple Inc, Skylum Software.

Keep going

It can be tricky to completely
remove an object in one go, so you may
need to go back over it. This is also true
if the result looks unnatural - another
fill with the finger can smooth out any
patches that have a strange look to them.

Restore if necessary

The opposite of Erase is Restore,
which puts back any areas of the image
you choose. Using it is as simple as the
Erase tool - you select it, and brush over

the area you want to restore using your
finger or Pencil.

Touch up with Pencil

The Apple Pencil, if your device
supports it, can be a good way to touch
up small areas. The app has a tendency
to produce repeating patterns that need
to be individually smoothed away, and
the Pencil is perfect for this.

Keep it small

Stick to smaller areas if you can.
Trying to erase a large area at once leads
to more errors, such as the app repeating
an object from elsewhere in the image.
One way around this is to erase an

object in stages.

SEP 2023 | 41



@ Create

Master Shortcuts on €Watch

Unlock the power of ta_s|< automa_ti_on_by_accessing shortcuts from your wrist

=

REQUIRES
watch0S 7 or later,
i0S 12 or later

YOU WILL LEARN
How to find, create, add,
run and organize task-
speeding shortcuts for
your Apple Watch

IT WILL TAKE
15 minutes

14:59 ¢

4 Search

{ Shortcuts

Apple Watch

Q Search

YOU'VE LIKELY COME ACROSS
Shortcuts on the Mac, iPhone
and iPad but the ability to
trigger specific tasks with ease is
also available on the Apple Watch. By
adding shortcuts to your wearable, you can
trigger a host of actions in an instant
without needing to pick up your iPhone.
You could quickly calculate a tip, use
Shazam to figure out a song’s name or even
add some “missing” functions - there’s
no Notes app on the Watch but that doesn’t
mean you can’t create and save notes.

HOW TO Set up shortcuts on @watch

In that sense, Shortcuts can unleash
the potential of your Apple Watch by
allowing most (although not all) iPhone-
created shortcuts to work on your wrist.

As you will see, you can make use of them
via the Shortcuts app, a complication or an
Apple Watch Ultra’s Action button. But you
can also ask Siri or set up automated
shortcuts via the Automation tab in the iOS
Shortcuts app, making for a truly hands-
free experience. Don’t be afraid to play
around with these time-saving hacks.
DAVID CROOKES

Shortcuts

("] All Shortcuts 20

_‘“\,L

Shazam shortcut

=

Music Quiz

Launch Shortcuts
Let's start by opening the
Shortcuts app on your Apple Watch
where you will find a list of available
shortcuts created by Apple. To run one,
simply tap it. Some will just run a process
while others will ask for input.
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&_] My Shortcuts 12
(1) Share Sheet

) Apple Watch 5

Folders ~

Organize shortcuts
You can reorder and remove your
shortcuts. Open the Shortcuts app on your
iPhone, tap the Shortcuts tab twice and
select Apple Watch. You will again see a
list of shortcuts that are available on
your Apple Watch.

Rename

Netails

Make your changes
Tap and hold a shortcut. You can
now either drag and reposition it or make
alterations. Use the menu to rename or
edit a shortcut, share or duplicate it,
remove it from your Apple Watch or
even delete it entirely.

Image rights: Apple Inc.



Water data.

Allow Access

® M B

, Add some more
S You're not limited to these
particular shortcuts. For more, tap the
Shortcuts tab in the iPhone Shortcuts
app - to view All Shortcuts. If you see
one you like, tap its “."” menu for the
details screen then tap the “i" icon.

Shortcuts

< Settings
iCloud Sync a

Private Sharing

Other shortcuts

=" There's a flourishing community
of third-party shortcuts (look at[www]
[reddit.com/r/shortcuts|or|https://
[shortcutsgallery.com). Contacts can
share shortcuts too. For safety, open the

Settings app on iPhone and tap Shortcuts.

Done

2 Askfor Text with What
would you like to write?

Create note with in

)

Play around

This shortcut lets you create
Notes. It uses the “Ask for” Input action
to get you to write a note, then calls
on the Notes app and the Create Note
action to save the note. Tap Done,

and add like in the steps above.

oy

Details Privacy Setup

g Add to Home Screen

2 showin Share Sheet

s Show on Apple Watch

, Toggle the button

B Activate "Show on Apple Watch”
and select Done in the top-right corner
twice (a note beneath the button will tell
you if some processes won't run). The
shortcut will transfer and appear in

the Watch's Shortcuts app.

¢ Shortcuts Advanced

Allow Running Scripts

Allow Sharing Large Amounts
of Data

, Engage security

As well as toggling on Private
Sharing, tap Advanced. Determine
the level of access shortcuts can have,
preventing them from running scripts,
sharing large amounts of data and
deleting stuff without your permission.

Modular

5 1005

am shortcut

Use complications

» Want a Shortcut to be available as
an Apple Watch face complication? Touch
and hold the face, press Edit, and swipe

left to find the Complications screen. Then,

tap a complication, and scroll to find the
Shortcut you want to use.

Shortcuts for Accessibility F

Get Stuff Done See A

Find shortcuts

S If you want to discover and
potentially even use more shortcuts,
select the Gallery tab in the iPhone
Shortcuts app. Tap “+" on a shortcut
you want, then head for the Shortcuts
app and follow steps 4 and 5 again.

v Done

© Add Action

Create your own

= Want to produce your own
shortcut? You'll need to do that in the
iPhone Shortcuts app. It warrants an entire
tutorial of its own but tap the Shortcuts
tab, select “+", tap Add Action and start

to build your shortcut.

# Actian

Use Watch Ultra

Shortcuts can be assigned to

the Action button on an Apple Watch Ultra.
Open Settings on the watch; tap the
Action button, select Action, then tap
Shortcut. Tap “<" then Shortcut and

the shortcut you'd like to assign.
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Solid-state drives for Mac

They are faster and more reliable, but think carefully before spending

YOU WILL LEARN
How solid-state drives
store data, and the things
to look out for when
buying and using one

SSDS OFFER
A QUIETER,
MORE
RELIABLE
AND FASTER
WAY TO READ
AND WRITE
YOUR DATA

BE
KEY FACT

Unlike with a hard drive
where defragmenting
brings scattered blocks of
data together to increase
the speed at which they are
read, defragging makes
absolutely no difference

to the performance of an
SSD. In fact, defragging

an SSD will only increase
the number of writes on
the drive and this will cause
unnecessary wear and tear,
reducing its lifespan.
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HEN YOU BUY A NEW MAC, you can
choose how much storage you want.

Our advice? Don’t rush your
decision. While opting for a higher capacity
drive is going to cost you hundreds or, in
some cases, thousands, making the correct,
upfront choice will determine how useful
your Mac will be in the future. One thing’s
for sure, don’t bank on going larger later
down the line!

Not too long ago, the situation weighed
less heavily on your wallet. The choice of
high-capacity internal computer storage
was generally limited to hard drives (highly
mechanized devices which use a head to
read and write data on rapidly spinning
discs, aka magnetic coated platters) and
they were easier to access and relatively
inexpensive compared to the solid-state
drives (SSDs) that Apple now places in
its modern machines.

Yet there are myriad reasons for why
you shouldn’t grumble too much about
the move towards SSDs. Ever since Apple
made them a factory option for internal
storage for the MacBook Air in January
2008 - and ditched hard drives for
good three years ago -
they’ve offered a

The Mac Studio’s SSD delivers up
to 7.4GB/sec of performance and
offers up to 8TB of storage space.

quieter, more reliable and faster way to
read and write your data. They also
generate less heat, draw less juice and offer
shorter startup times. But how do they work?

LIFE AHEAD
Rather than containing moving parts,
SSDs store persistent data in blocks on
flash memory chips. This data is saved to
individual memory cells, with the number
of bits stored on each cell dependent on the
type of NAND flash memory being used.
A NAND made up of Single Level Cells
(SLC) will save one bit of data per cell,
for instance, while Multi Level Cells
(MLC) save two bits and Triple Level
Cells (TLC) save three. All of this is
important to some degree because the
type can affect how long an SSD lasts.
What’s more, the larger the capacity, the
more time you’re going to get out of it.
To explain, SSDs support a limited
number of writes — a figure expressed as
total bytes written (TBW), at which point
degradation kicks in. The more bits that
can be written to a cell, the quicker it will
wear out (although firmware
ensures wear is evenly
distributed).




> HOW REPLACEABLE ARE THE MAC'S INTERNAL SSDS?

If you have a Mac with a hard drive
then it's likely you'll be able to replace

it with an internal 2.5-inch SATA SSD.
The process is more straightforward
with a MacBook and Mac mini than with
an iMac (the latter requires cutting the
adhesive binding the display from the
casing) but, having formatted the SSD
using Disk Utility, you can then benefit
from faster access speeds.

Sadly, replacing internal SSDs with
new ones isn't as straightforward. Macs
with the Apple T2 Security Chip and
those with M1 and M2 silicon won't let
you simply swap out an existing SSD

with another. These chips contain the
vital storage controllers that indicate
where data should be read from and
written to and they can’t be bypassed.
Frustratingly, you're also limited
when it comes to the Mac Studio
despite the fact that this actually has
a removable SSD. Again, the controller
is built into the silicon chip, so you
have to change the existing SSD with
one that has the same configuration.
That's great for replacing a worn SSD
but not good if you were hoping to
use a larger-capacity drive than
you originally paid for.

If you're looking for an external SSD, the Crucial
X8 is inexpensive and highly recommended.

Likewise, the more capacity you have, the
more cells you have to play with, so, in
general, opting for a high-capacity drive
with SLCs is going to prove more durable
than a low-capacity drive with TLCs.

Now, Apple hasn’t publicly revealed
the type of NAND it uses and we don’t
know the TBW of its SSDs. Even so, if you
opt for a larger internal solid-state drive
when buying your Mac, then it should last
longer but bear in mind that things are not
always quite so straightforward - a couple
of years ago, a small number of users of
M1 Macs were reporting excessive data
writing potentially affecting the SSD’s
lifespan, although a macOS update
appeared to resolve this.

It has also emerged that the number
of NANDs being used in the SSDs of more
recent Macs has been having an adverse
effect on performance. The 256GB SSD in
an M1 Mac has two NAND chips while the
256GB SSD in the M2 model uses one. As
a consequence, the former model is up to
50% faster than the latter but the issue
seems more prevalent with base-level
storage - higher capacity upgrades
appear just as fast as before!

A LONG ROAD

But that’s now. What about the future?
Well, there have been some eye-catching
advances. Samsung has invested in V-NAND
SSDs that stack cells in multiple layers on a
single chip so higher capacity SSDs should

become commonplace. PCle 5.0 M.2 SSDs,
meanwhile, have proven to be at least
two-thirds faster than previous models,
plugging into PCle 5.0 slots currently
supported by a handful of PC motherboards.
The M1 Ultra-powered 2023 Mac Pro comes
with six PCle 4.0 slots (as well as one PCle
3.0), so should offer twice the drive speed
of the Mac Pro that preceded it.

There are options for anyone who has
nailed down the SSD capacity in their Mac
- notably external SSDs. These drives will
not only expand storage capacity but also
allow you to back up your Mac or quickly
transfer data from one computer to another.
Just identify how much capacity you’d need
(such as twice the storage space of your
Mac for backups) and look for sturdy
drives with a high TBW that adhere to
the IP67 standard, thereby protecting
against water and dust.

One thing’s for sure, external SSDs are
a simple option, connecting via USB-C
or Thunderbolt and drawing their power
from either port. Thunderbolt support will
be available on SSDs for Macs, with the
Thunderbolt data transfer protocol speeding
up access, while USB-C will be an option on
less expensive SSDs. You won’t really notice
the difference in speed between the two

unless working with lots of large media files.

What you will notice, however, is the cost.
External drives are cheaper than the
internal upgrades offered by Apple. They can
be used as startup disks too. DAVID CROOKES

[—=1=]
==

KEY FACT

You can use DriveDx
(https://binaryfruit.com/
[drivedy) to check how
much data has been written
to a Mac's internal SSD;

it will also let you know

if the drive is failing.
SMARTReporter{(https:/1
corecode.io/smartreporter)
does a similar job. If the
drive is failing (and your
Mac is still under warranty),
you should back up the
data and pop to an Apple
Genius Bar for assistance.
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aASK

Learning in the right place

FOR THOSE WHO are
e disappointed that, in

macOS 14 Sonoma, Apple
hasn’t joined Microsoft or Google
in the rush to include Al like
ChatGPT, there are two good
reasons: knowledge and privacy.

Those wildly popular large

language models don’t deal in

> Rescue tracks from an old iPod

knowledge, but persuasive
language. Try pinning down
ChatGPT on a topic in which you’re
an expert, and you’ll quickly find
its overconfident answers are
devoid of insight, and Wikipedia is
generally more trustworthy.

But most of all, this type of
artificial intelligence depends on

EXPERT
ADVICE

Our resident genius
Howard Oakley solves
your Mac and i0S problems

off-device processing, so
interactions are sent to be stored
and processed on someone else’s
servers. Sonoma and Apple’s
sibling operating systems instead
prefer to learn from you in the
privacy of on—-device processing,
and no one else will ever know the
words it’s autocompleting for you.

Can | still rescue the music tracks from my working iPod (5th generation) and transfer them

to my MacBook Pro 20207

You may well still be able to do this by
connecting your iPod with a USB cable
and adaptor to a Thunderbolt port on
your MacBook Pro. When you connect
them and the iPod appears in the Finder,
select it and uncheck any option to
“Automatically sync when this device is
connected” if it appears, to stop your Mac
from trying to sync with the iPod.

If the iPod mounts in the Finder,
navigate to its iPod Control > Music folder,
for which you may need to show hidden
files by pressing Cmd+Shift+".". The

Nelly Furtado
Loose
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folders inside that contain music tracks
stored on the iPod, and need to be copied
to a convenient folder on your Mac, so
you can organize them there. Within them
you should find .mp3 and other music
files with

seemingly f,

random names, L

and you will

need to add

those to your Podcasts

Mac's Music Extras

Iibrary. Settings
Shutfle Songs
Now Playing

Before importing your files, open the
Music app and its Settings. Decide
whether you want Music to copy the
music files into its library, which you set
in the Files pane there. Import the tracks
you want using the Import command in
Music's File menu.

If that doesn’t work, you could
still have success using a third-
party product such as AnyTrans
on your Mac, as explained at

ttps://bit.ly/3X0Vc34.

0Id iPods may still be
able to connect via
USB, allowing you to
rescue your favorite
tracks from them.
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Quick-fire
questions
& answers

HOW TO TRACK

ACTIVITY WHEN I'M
IN A WHEELCHAIR?
In the Health app, tap
your profile at the top

> Bring order to Home Screen chaos

What's the best way to bring order to the apps on my iPhone? Is there
an app to organize them into Home Screen pages?

In the past, you could
organize an iPhone’'s Home

to on a separate Home
Screen page. You can then

Library, you can touch and
hold the icon and select "Add
to Home Screen”.

Screen layout in iTunes, and
the AnyTrans tool from
pttps://anytrans.imobie.com]
supports that and more at a
price for continued use. Other
apps claiming to help provide
themes, but little more. The
best way to tackle thisisin
iOS. If your apps are all over
the place, then you can reset
them to show bundled then
other apps in alphabetical
order: in Settings, head to
General > Transfer or Reset
iPhone > Reset > Reset Home
Screen Layout.

Put the four apps you want
instant access to in the Dock.
To edit that, touch and hold
the Home Screen until the
icons jiggle. You can also
add folders to the Dock if you
want; make them by dragging
oneicon on to another when
in edit mode.

Your iPhone's Home
Screen is best kept for your
most-used apps, arranged in
pages according to their
theme or purpose. Those
apps you use rarely are better
removed from the Home
Screen and left to the App
Library, where you can search
for them by name, or view
them by category. If you need
to add an app back to the
Home Screen from the App

Image rights: Apple Inc

You can also choose to put
apps that you want
infrequent but ready access

o

Health

ﬂ, w

AIRMAP

AirMap

0

Météo-France

Parrot

FreeFlightg

o

hide that page when in edit
mode by tapping the Home
Screen navigation tool and
unchecking it there.

Met Office Wesa

@

Repo Browser Wi-Fi Checker

]
INHS

NHS App

Touch and hold
on a Home
Screen page until
the icons jiggle
to make changes
to its apps and
the Dock below.

right, then Health
Details > Edit >
Wheelchair. Set that to
Yes to switch from
tracking walking steps
to wheel pushes, and
back to No when you
want to count

your steps again.

WHY ARE

MANY WIDGETS
MISSING FROM THE
TODAY VIEW?

After tapping Edit in the
Today View, instead of
adding widgets from
the short list offered by
the Customize button,
tap “+" at the top left
and you'll see a fuller list
of all those available on
your device, just as
when adding a widget
to the Home Screen.
Customize them by
touching and holding
the icon and choosing
Edit Widget.

Ventnor ¥
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Mac Software

Resolving riddles and restrictions with what
you want to run on your Mac

Quick-fire > Where have all my Adobe fonts gone?

HOW TO SHARE
MULTIPLE PHOTO
LIBRARIES IN Fonts that are installed and activated using those numbers is in livetype/.c/entitlements.
iCLOUD? Adobe Fonts, through an Adobe Creative xml and could be used to rename copies of
When you share your Cloud subscription, aren’t installed in any of the master files, but don't try tampering
Photos library in iCloud, the standard Fonts folders found in macOS with those saved by Adobe.
only the System Photo Library folders, such as those in your Home or There is an open source tool, Adobe
library is used. Check main Library folder. Instead, Adobe intends Fonts Revealer, available from pttps://]
that in Photos’ settings, that you manage them through its website that can copy and decode the
in the General tab and the Creative Cloud app. Therefore, font names, although it requires that you
(shown at top). When you won't see those fonts displayed with install Icdf-typetools using the Brew system.
you select a different regular fonts in the Font Book app orin Its use is explained in the readme file there,
Photo library by holding other macOS font managers. although we're aware that it might not yet
the Opt key when If you need to locate them, they should work fully in Ventura.
opening Photos, that appear in hidden folders in your Home folder Before trying to do anything with the fonts,
doesn't alter unless you Library, in Application Support/Adobe/ you should check that it's permitted under
change itin Settings. CoreSync/plugins/livetype/.r. You'll need Adobe’s license agreement. It's likely that

to show hidden files using Cmd+Shift+"." to embedding them could be a breach of Adobe's
HOW TO EXCLUDE see that folder in the Finder, where they're not intellectual property rights, unless explicitly
.DS_STOREFILES given names but numbers instead. The key to allowed under the terms of its license.
FROM ZIP ARCHIVES? L —— N ——

Some compression
apps offer this; if yours

' iler Ore comadobe, MDCHeper SIIBHETES . Cache.json 2 fivetype
doesn’t, and keeps B Aeivsiats B Comon 13686755, -ne o
: H =2 e I comentatons B} 58075172 Phbasdd di
enclosing these hidden = =i o s
. .. . 2 siroace BN Creative Cloud Libraries * ABOTAITE. se0d. db-wal
and invisible files, Motk A Plas Discrir | Sik & Mikaigiec Sy T— 25 cssSaniceMansger AesLEnacty
i i S BE AvIS LLE 1 ¢S6ServiceManager B CoCo_a5e. Sdebail.dt
consider removing Home i BB Oigs Ecktions B coou_sea. wsesatan
. B3 Alfn 7 Cruummuedver L] 12 cloudnative
them using BlueHarvest gl s o T
from the App Store. oo s i SR o
That can also exclude - E n s T B = SR - 513
files with names hachet dsbeboores Adobeltick  Aubatf  Adobefons  Adgsnyon B2 i B Evarorise o ki
) ) web T P [] AbFants = V@
starting with ._ that i
contain extended e § irons = T S p| S A

Resgular

& My Fonts

attributes, which can Suggstions b hlp you succeed F Craative Cloud All Appé
also trouble Windows 8

ABCDEFGHIKLMNOPQRSTUVWXYZ
abedefghijklmnopgratavwxyz
1234567890

d oth £] English Boid ltalic
ana other users. BN e s
Description
Fussian Adoibe D i
i s wvanagar
""" 5 Simpiified C Adoie Fan et Sid )
Language Support
] Traditiona Adobe Fangsarsg Std
%) Ukiminian obe Garamond Pro
i e identifiers
Recent + Adobe Gathic Std
o + Adtaibe Hebrew
T Avenit Usage
. Addote Helt St
& Foud Width
Adoibe Kati Std st SponTyon FEsSo
2 Fun Detalis

e M

Fonts provided through Creative Cloud's Adobe Fonts don’t appear in Font Book, as they're tucked away in a hidden folder.
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> Empty Mail messages

When | open messages in Mail, many of them look empty, but their
contents usually appear correctly if | quit Mail and open it again. How

can | get to read them first time round?

Tech Support & Techsplanations

Mac|Lifes®

Quick-fire
questions
& answers

HOW TO JOIN TEXT

This error is occurring because Mail isn't
rendering the content of those messages.
One control that could change thatis in
Settings > Privacy, where you should uncheck
the box to Protect Mail Activity, although
you're likely to want to keep the option to
protect your IP address
enabled. Thisis also a =
good opportunity to
ensure that your copy of
macOS is fully up to date,
and to upgrade to Ventura
if possible, as it fixes many
problems like this.
Otherwise, potential
solutions are
generic. Have a good =

housekeeping session =

mailboxes. If you have thousands of old
messages, try moving many of them off into
archives. Once you have tried those, select
your Inbox, then use the Rebuild command
at the bottom of the Mailbox menu to put it

back into order.

TOGETHERINA
NUMBERS
FORMULA?

With text to be joined
in cells B2, C2 and D2,
for example, just
enter the formula
CONCAT(B2,C2,D02)
where you want
them joined. When
necessary, you may
need to give textin
those cells trailing
spaces to lay the
result out properly.

HOW CAN | REMOVE
THE BACKGROUND
FROM IMAGES IN
PAGES?

to reduce the size of your

> Plagued by an old email address

Whenever | open a new email or go to enter my email address in a form,
an old email address appears first in line. How can | rid my Mac of that

old and now unused address?

In Ventura and later,
select the image, and
the Image tab in the
Format sidebar, click
Remove Background.
Removal may not be
possible in all images —
you may need to
remove specific colors

This normally occurs when that obsolete
email address is still stored in your card in
Contacts. Open Contacts and scroll to the
very top of the list of names, where you'll see
My Card, which macOS uses as the source for
autofill and related features. You can also use
the Go To My Card command in the Card
menu to take you straight there.

Click on the Edit button and check through
that entry carefully, removing any old email
addresses still there, and ensuring the
address given for Home is the one you want
to have entered automatically into forms.
Also in the Card menu is a command to check
for duplicates, which is worth using too.

When you do this in iOS on a device, there's
another useful feature to check Linked

Image rights: Apple Inc

Contacts, which is listed at the foot of My
Card. The final check needed is to ensure

that your address
bookisn't
connected to
multiple accounts,
as shown in the
Accounts tab of

Contacts’ Settings.

Now you just need
to give your Mac
and devices a few
minutes to sync
over iCloud, and
your phantom
email address
should be gone.

i Cortbets
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by pressing the Opt key
while dragging over the
colors with the pointer.
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Email addresses and other information used for autofill is taken from
entries in your My Card in Contacts.
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Quick-fire
questions
& answers

CAN AMAC MOUNT
TWO VOLUMES WITH
THE SAME NAME?
Yes, although they'll
confuse you. macOS
identifies APFS volumes
not by name, but by the
volume's UUID in
alphanumeric
characters. Volume
UUIDs must be unique,
or chaos results. macOS
then gives each volume
a distinctive name
when it's mounted, so
apps are able to tell
them apart.

HOW TO REPLACE
TEXTEDIT AS
DEFAULT TEXT
EDITOR?

In the Finder, selecta
plain text file with
extension .txt or .text.
Display the Get Info
dialog using the
command in the File
menu. Open the “Open
with:" section in the
dialog, and set your
replacement text editor
in the pop-up menu.
Then click Change Al
below to apply that
change to all text files.
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mac0S

Shine a spotlight on the solutions to
your most irritating Mac problems

> False error in Disk Utility

When | run Disk Utility’s First Aid on an APFS volume in Ventura 13.3.1, it
returns an error and warns me to back up that volume. How can | repair

that volume, or is it really broken beyond repair?

This is a long-standing bug in
Disk Utility's First Aid feature
that goes right back to the
introduction of APFS with
High Sierra. Select a volume
or APFS container (like a
partition), run First Aid, and
Disk Utility calls a command
tool named fsck_apfs to do
all the hard work. That
requires the volume or
container it's going to check
and repair as necessary is
first unmounted, butin
macOS prior to Ventura

View Window Halp

version 13.4 it often fails
because Disk Utility is unable
to unmount the disk. That
returns an error that looks
serious, when it's actually just
an error in the app.

This has been fixed in Disk
Utility version 22.6, bundled
in Ventura 13.4, in most
circumstances, although it
still can occur occasionally.
Update macOS so that it uses
this new version, and try that.

If First Aid still returns this
error, as it can when checking

Disk Utility

m— . SE—— S

Running First Aid on “Samsung990pro2TR - Data”

a Data volume that's not part
of the current startup system,
select the volume or
container and manually
unmount it using the tool at
the top of the window. Then
try First Aid again. When
that has completed, select
the volume or container again
and use the tool at the top to
mount it back.

And if that still won't
work properly, start up in
Recovery mode and use Disk
Utility there instead.

Q First Aid process is compiete. Click Done to continue.

Semsung@A0mo2TH volumes

Hide Details

Checking the encryplion key stroctures
Chacking volume devjrdisk5s1
Checking the APFS volurme superblock.

0oL TE | The volume Samsung290pro2TB - Data was formatiod by diskmanagementd

{2142.81.1) and last modified by apfs_kext (2142.120.7).
Checking the object mag.
Checking the snapshot metadata tree.

Checking the snapshot metadata

Checking the document ID tree.

Checking the fsroot trese,

Checking the extent ref tree.

Varifying volume object map space.

Verifying aliocated space.

Thu wolume [devirdiskSs1 appears to be DK
Flle system check exit coda is 0.

Restoring the original state found as mounted.

Oparation succassful.

APFS Data Volume

Disabled

PCI-Exprass

disk5s

G

jided in the Ventura 13.4 update now runs First Aid more reIiany._,)"'
y

U snapshols

/
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Quick-fire
questions
& answers

WHY CAN'T I SEE
.DS_STOREFILESIN
THE FINDER?

To view hidden files
you'd normally press
Cmd+Shift+"", but that
won't reveal .DS_Store
files. The only

<key>
ind; public by, RSA, 2, (65- B Save sxpanded filss: it same direciory a5 archive =
Usage! Encrypt, Derive, Verity
Aftar expanding:  leave archive slone. §
+ Roveal expanded itemis) in Finder

' Keep expanding If possibie

Date Modifed Expires Ketychan
e ey o - g

<y poblc ey = o Save archive:  into same directory as files being archived &

Use archive format:  Apphe Encrypted Archive &

Archiving “B0cryBt ... After archiving:  leave files alons [

Reveal archive in Finder

------- You can't cl
password used for Apple
Encrypted Archives, as it's
not a password but half a
secure key pair.

Password:  17838-91971-75402-10178-74264-91858
3 Store Password in Keychain

° A ° way to see themisin
> Flnd an encryptlon password Terminal, using a
When | create an encrypted Apple Archive using Archive Utility, it
generates the password automatically. Where's that stored, as | can't

command like Is -a, or
Is -la for more info.

find it in Passwords in System Settings? HOW TO EXTRACT
THE IMAGES
FROM AN RTFD

Apple Encrypted Archive is one of the options key pair stored as a public key in your DOCUMENT?

available in the bundled app Archive Utility,
best found using Spotlight search. Although it
refers to setting a password for its
compressed and encrypted files, in fact you
can’t change the 30-digit number that it offers
to use, and unless you're exceptional at
remembering long numbers, you'll have to
store it in your keychain. This isn't a password
at all, so you won't find it saved alongside

keychain, normally the default one named
login. As these aren't named in any
recognizable form when they're stored there,
the only way to find it would be to inspect
every key in your login keychain, looking
for that key chosen for you by the app.

So the only practical way to use this
encryption key is by saving it to your keychain,
and leaving it to macOS to remember it

Duplicate the document

using Cmd+D. Remove

the extension .rtfd from
the duplicate and it
changes into a folder.
Inside that are all its

graphics files, and its
text contents areina

Rich Text file named

passwords for websites. It's actually one of a

when required.

TXT.rtf.

> Comment and Comments aren’t the same

Although Comments for my files appear correctly when shown in the Finder’s Get Info dialog,
they're not shown as Comments in the Finder’s Quick Look preview. Is this a bug?

No, although it might as well be. It's the
result of macOS files having two
different types of comment available in
their metadata.

The comments you see and edit
in the Finder's Get Info dialog are
more fully known in macOS as Finder
or Spotlight Comments. Although
macOS stores a copy of those attached
to the file as an extended attribute,
the primary source of those comments
is the hidden file in many folders
named .DS_Store.

Image rights: Apple Inc

If that file were to be deleted, all
those comments would be lost. There
are also problems in syncing the
version stored in extended attributes
with that in the .DS_Store file. When
using Spotlight's Find feature in the
Finder, those comments are referred to
as Spotlight Comments, but they can’t
be shown in Quick Look preview info.

Instead, Quick Look can show
regular Comments, which aren’t saved
in hidden .DS_Store files, but only in a
different type of extended attribute

attached to files. As
the Finder doesn't
provide any way to
edit those, they're
seldom used except
through third-party
apps. such as
Metamer (Free,
https://bit.ly/3DcolL4X), that give
more extensive access to metadatain
extended attributes. They can be
found using Spotlight, where they're
referred to as a plain Comment.
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Your iPhone is packed with tools to help you get the
most out of it. Here we celebrate the best of the
lesser-known iOS tips and tricks

WRITTEN BY PETER WOLINSKI

OUR iPHONE COMES loaded with
Y handy hidden features and hacks

that can make it much easier and
more fun to use. In our opinion, it’s this
plethora of little-known features that
help make iPhones some of the best
phones out there.

But do you know all of them? Well,
there are so many that we'd be willing to
bet you probably don't. To help with that,
we've rounded up 28 of our favorite
iPhone hidden features that everyone
should know, and how to use them, with
step-by-step walkthroughs where a little

more explanation is needed — hopefully at
least one or two are new to you.

Just a quick note before we begin:
most of these hidden features have been
embedded within iOS for a while, so even
people using older devices should be able
to utilize at least some.

To ensure we're all on the same page,
though, make sure your device is up to
date by going to Settings > General and
tap Software Update. If an update is
available, tap Download and Install.

Once downloaded, tap Install Now. With
that done, you're good to discover more.

Image rights: Apple Inc, Getty.



Customize the iOS Control Center

One iPhone hack that makes life
easier is being able to customize
Control Center. By adding your favorite

you can access them with a simple swipe
down, even when your iPhone is locked.
This is super handy when you need a
feature immediately. We find Music

Recognition the most useful — no more

fumbling around Home Screen folders,
desperately trying to find the Shazam app
and most-used widgets to Control Center,
. Control Center, go to Settings, then tap
- Control Center. Scroll down to More

- Controls and add any controls that'll be
- handy ata moment's notice.

before the song ends. To customize your

With Back Tap enabled, you can assign a range of different functions to

both a double and a triple finger tap on the back of your phone, kind of
like gestures on a trackpad. You could, for example, use Double Tap for your Flashlight
and Triple Tap for your Camera — these are both incredibly useful when you're
using your phone at odd angles and can't reach the Lock Screen icons or the

Control Center pull down.

There's a range of different time-saving and accessibility functions you can assign,
and you can even combine the feature with Shortcuts for even more customization. To
enable Back Tap, open the Settings app and tap Accessibility. Next, tap Touch, then tap
Back Tap. Tap either Double Tap or Triple Tap to assign functions to each.

i0S comes with advanced sharing

abilities using Siri. Instead of
sharing the old—-fashioned way by
pressing the share button, you can use
Siri to share whatever is on your screen
with a contact. It's not a life-changing
feature, but comes in handy when you
need to share something quickly or don't

Image rights: Apple Inc, Getty.

have your hands free to do so. Animage
or photo can be shared, as can a song
you're listening to on Spotify. If Siri can't
share your screen, for example with the
Weather app, it'll take a screenshot and
send that instead. To share your screen
with a contact, simply say “Hey Siri, share
this with...” whomever you'd like to seeit.

28 hidden iPhone features

Access the iPhone’s
hidden trackpad

Even people with the smallest

hands can find the compact
keyboards of phone screens allittle
hassle-prone, and scanning through
large chunks of text to find the exact

spot you want to change used tobe a
tricky task. To help with this, your
iPhone features a hidden trackpad,
which can be used to scan easily and
precisely across your screen. Just
press and hold the spacebar on your
iPhone’s space key to turn the keyboard
into a trackpad.

While many modern iPhone models

like the iPhone 14 Pro are
waterproofed to the IP68 standard, it's
still no fun to get stuck out in the rain.
Handily, the iOS Weather app has you
covered with an easy-to-read interactive
weather map so you can easily see the
day ahead's weather and never get
caught short again. With a scrolling
12-hour forecast for anywhere on the
planet, featuring temperature,
precipitation and air quality overlays, and
all of your locations pinned, the app’s
weather map virtually turns youintoa
weather reporter, and is difficult to stop
using once you've started. To enable the
interactive forecast, open the Weather
app and tap the mapicon in the bottom-
left corner of the screen.
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Drag and drop
files and photos
between apps

A little-known feature that can

save you a ton of timeis the
ability to drag and drop between iPhone
apps. With the drag and drop feature,
you can quickly and easily import an
image or video from your photos or a
web page, or even a PDF from your files,
and drop itinto an app like Notes or
Messages. This hidden feature can
be allittle tricky the first time around.
Here's the gist: tap and hold on the file
you want to move, then move it toward
the top or bottom of the display. Then,
while continuing to hold that file with
one finger, you swipe up from the
bottom of the screen with another
finger and open the app you want
to drag yourfile into.

It used to be that scanning a

document to turn physical pages
into a digital file required a dedicated
scanner or all-in—one printer. And
indeed, for perfect carbon copies, this
is still the case. But what if you just
need to quickly turn that line from your
textbook into a quote in your notes
app? Unsurprisingly, iOS has a neat
solution, and your iPhone's camerais
also a handy tool to convert physical
text into digital. To get started, open an
app you want to scan text into — this
could be Notes, Messages, or any other
app that lets you enter text. In the
text-entry area, tap and hold for a
couple of seconds then release your
finger. You should now see a scanner
icon and “Scan Text" appear.
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Like us, you might've thought the native Calculator app was a little basic at first,

especially when compared to those giant calculators you used in math class
at school. Well, maybe you should give it another chance: the humble Calculator app
actually has a few tricks up its sleeve. Turn the iPhone landscape to unveil a scientific
calculator, and swipe left or right at the top of the display to delete digits.

HiRise Pro for MacBook
justable stand for
MacBook | Support a
hauteur réglable pour
MacBook
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Enter hidden codes
to unlock features

If you've ever typed in a code

to find your IMEI or phone
number (*#06#) when selling your
phone, you may have an inkling of
what this one’s about. What you
might not know, though, is that as
well as codes to find those numbers,
there are also codes to tell your
iPhone to do a whole range of things,
from hiding your number (*67
followed by the person’s number and
area code), to diverting calls (*61*
when you don't answer, *62* when
youriPhone is unreachable, or *67*
when your iPhone is busy) and even
launching a field test mode (turn
off Wi-Fi, then enter 3001#12345%)
to see data about your cellular
connection. Simply open your Phone
app. then head to the keypad and
dialin one of the codes.

Image rights: Apple Inc, Getty.



Siri Suggestions

Kevin Callus

calculator

calendar

calendar 2023
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Search anytime, anywhere using Spotlight

Spotlight search saves a lot of time when you need to get to something fast.

To take that one step further, with i0S 15 you can now access Spotlight directly
from your Lock Screen, meaning you can search immediately without needing to wait
for Face ID to do its thing. To access Spotlight while locked, simply swipe down from
anywhere but the top right of your screen (as this will open Control Center).

16:07

4 Search

< Back

LED Flash for Alerts

LED Flash for Alerts

Ever get jealous of Android users with their neat LED notification lights?

What you may not know is that the iPhone has a little-known accessibility
feature which gives users a notification light, too. The iPhone’s LED flash can be set
to flash for alerts, such as messages and other notifications. This is more of a visual
accessibility tool than a customization feature, as you'll only really notice itin the
dark or if your phone is on a surface facing screen-down. But it's still pretty handy,
especially if you miss naotifications a lot when on silent. Open the Settings app.
scroll down and tap Accessibility. Tap Audio/Visual, then scroll to the bottom and
toggle on LED Flash for Alerts.

Image rights: Apple Inc, Getty.
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28 hidden iPhone features
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Use Face ID with
a Mask

Face ID is most accurate when it's set up for
full face recognition only. To use Face ID
while wearing a mask, iPhone can recognise
the unique features around the eye area to
authenticate.

Use Face ID with a Mask
You won't need to wear a mask
during setup.

Don't Use Face ID with a Mask
You can set up later in Settings.

Set Up Later

You can still use Face ID when
you're wearing a mask or other
facial obstruction like a scarf. Once you
turn on the switch to use Face ID with
amask on for the first time, you'll have
to rescan your face. The good news
is that you can turn the feature on
and off without having to rescan
your face each time. The bad news is
that this makes your iPhone inherently
a little less secure, as it is using less
biometric data to unlock your phone.
To enable Face ID with a mask, open
the Settings app and tap Face ID &
Passcode. Enter your passcode and
toggle on Face ID with a Mask.

SEP 2023 | 55



Cast Harry Potter
spells using Siri

On top of being a powerful pocket-

sized computer and camera, your
iPhone also doubles up as a magic wand.
That's right. You can now use Siri to cast
spells from Harry Potterand enable
functions without having to lay a finger
on your screen. To cast a spell, say “"Hey
Siri,” followed by one of three spells. Say
“Hey Siri, Lumos” to turn on your iPhone’s
Flashlight. Say “Hey Siri, Nox" to turn the
Flashlight off again. Say “Hey Siri, Accio
[app]” to open that app. More spells can be
custom-made using Shortcuts.

Instead of trying to find a place

or folder for any apps you don't
use — or you don't want people to see
— it's easier to just move them out of
sight completely with this little-known
trick. You can now remove an app from
your Home Screen without deleting it
completely, using the App Library. To
get started press and hold the app you
want to hide. After a couple of seconds,
a menu should appear with multiple
options. From this options menu, select
“Remove App”. Doing this will bring up
a second menu, press “Remove from
Home Screen”.

Share App

Edit Home Screen
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While we're all familiar with the
ubiquitous two-finger pinch
zooming function across touchscreen
devices, a simple yet relatively obscure
feature of iOS is one-finger zooming on
Apple Maps and Google Maps. This useful
trick enables the use of both Apple Maps

EGREGORY BLYD

Prairie
Village

Kansas City

City - ouri, |

and Google Maps one-handed and one—-fingered, which comes into its own when
navigating a new place with full hands. In map view, simply double-tap on the screen
and the map will zoom in slightly. To control the zoom level, double-tap the screen but
keep your digit held down on the second tap. You can now zoom in and out.

16:18
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< Back Background Sounds

Background Sounds (

Use When Media Is Playing

Stop Sounds When Locked

If you're in need of a bit of

relaxation, you can use the
Background Noise feature to pump
soothing ambient noise through your
AirPods, including rainfall, streams,
oceans, and white noise. We can vouch for
how useful this feature is when working,
helping to cut out distractions and focus
on work. What's more, unlike putting
on an ASMR or ambient noise track on
Spotify or Apple Music, this feature isn't
streaming anything, so it works even
without an internet connection. Just
open Settings and then tap Accessibility.
Next select Audio/Visual, then tap
Backgrounds Sounds and toggle on
Background Sounds at the top.

Image rights: Apple Inc, Getty.



If you've ever done a full-scale

rearrange of your iPhone’s Home
Screen, you'llknow how tedious it can be
to move each and every app one by one
— so don't. One of the handiest little-
known features of the iPhone is that you
can drag and move multiple apps all at
once. This enables you to clean up your
Home Screen in a fraction of the time. To
get started, tap and hold an app on your
Home Screen and move your digit slightly
until all your app icons start wiggling. Keep
your digit held down and use another digit
to tap and select other apps that you
want to move — you'll notice they’ll all be
grouped together as you tap each one.
Keep your original digit still held down and
use another digit to navigate to a place or
folder on the Home Screen. Then, release
your digit and they’ll all be moved.
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One of our favorite Messages features is the ability to track flights within a chat

—that's right, you can actually track live flights using Messages! If you've got a
friend or family member flying in to see you, or you're flying out to them, you can use
Messages to track the flight and see important information such as the flight's departure
time, whether the flight is running late, the expected arrival time and even the arriving
baggage carousel number. You'll also see a map showing where the flight is! Super cool.
To track a flightin Messages, one party must send the flight number as a message. Then,
long press the flight number and tap Preview Flight.

Image rights: Apple Inc, Getty.
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= ' Battery Level

Get custom battery
alerts with a shortcut

Ever miss those 15,10 and 5%
battery alerts your iPhone gives
you because your phone’s on silent?

Thankfully, you can avoid this using a
simple shortcut to set alerts at 30 or 40%,
giving you more of a heads up that you're
starting to get low. Better still, you can
have Siri announce your warning, so even
if you keep your iPhone on silent, you'll
never miss the battery warnings again. To
get custom battery alerts, create a new
automation in the Shortcuts app, tap
battery level and specify a percentage.
Then tap Add Action to customize what
your iPhone does once you hit that level.

Dark mode will turn your

phone’s theme to primarily
dark, which reduces the effects of
bright, white and blue light, in turn
making your phone more pleasant
and comfortable to use at night.
iPhones can even automatically
switch between dark mode and light
mode based on the time of day. To
turnit on, open the settings app and
then tap Display and Brightness. Now
tap the Dark check box underneath
the Appearance section. To go back at
a later point, you can simply tap the
Light check box.

To set dark mode automatically
on, on the Display and Brightness
menu, toggle the automatic slider
to on (green) and then tap options.
The default automatic setting is for
Sunset to Sunrise which will see your
phone switch to dark mode as the day
closes, and then to light mode as the
day opens. To change this, tap
Custom Schedule. Tap the time boxes
to select when you would like to have
light and dark modes enabled.
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Clear RAM

It's common for the iPhone to periodically slow down and

stutter, and you may have noticed your device occasionally
behaving sluggishly, particularly when trying to flick between
or open apps, or when performing tasks using intensive apps.
Sometimes, your iPhone may freeze altogether. Obviously, on
older phones this is more common, as their hardware is less well
placed to handle more modern software and applications. Very
often, what can be causing the freezing or slow down is that

AssistiveTouch

AssistiveTouch

your phone’s Random Access Memory (RAM) has become full.
So what do you do if your iPhone is operating slowly and you
think memory is the issue?

HOW TO CLEARRAMON IPHONE

Firstly, if you're using an iPhone without a physical Home button,
you'll need to enable Assistive Touch (you'll see why later). If your
phone does have a physical button, don't worry about this step.

Enter Passcode

Your passcode is required
to enable Face ID

BEEEN0 O O O

o Go to Settings, then tap
Accessibility. Select Touch
and then tap AssistiveTouch.
Toggle AssistiveTouch on. You'll
now see a circular button on

screen. Tap this buttonto see a
menu of touch options. The one

B Unlock your phone. Next,
in quick succession, press
the volume up button, then press
the volume down button, then
hold the lock button until a

shutdown menu appears. You'll
now be on the troubleshooting

o While you're in the
shutdown menu, tap
the AssistiveTouch button on
screen to bring up the menu.
Next, press and hold the Home

option. If you're on aniPhone
with a physical button, simply

D You'll now be presented
with alock screen,
signalling you've done it right
and to test it's worked, swipe
up and hold in the center of the

screen to open your app tray.
Each app you've had open will

shutdown menu which is used
for force restarting, recovery and
DFU modes and RAM clearance.

we'll need later is the Home
button. Next, enter the shutdown
menu, but not the normal one.

You need to know how to sign documents on your

iPhone. After all, when was the last time you signed for
something with a pen? Many contracts like lease agreements
and bank information are handled almost solely online now, and
with the rise of remote working, no one has time to send a
signed letter in the mail. Whether you need to sign a scan of
some paperwork or just add a signature to an email, it's easy.
Open the document in Photos, tap Edit, and tap the pen symbol.
Then tap the + and tap Signature, sign it and tap done.

Remove a photo’s background

Knowing how to remove the background of a photo on

iPhone is really useful, allowing you to instantly isolate
your subject from a distracting background. It also allows you to
set the subject of your image against a new background. You

may think you'd need to pay for photo editing software to do
this, but you don't. This all takes place in the Files app —

open this and locate the image to edit. Tap and hold the image
then select Quick Actions when the menu appears. Now

tap Remove Background. You'll see a new file appear next to the
original image. This file will be the image without a background.
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hold down on that. restart when tapped, which is
how you know your system

memory has been cleared.

If you don't know how to delete multiple contacts on an

iPhone, you're not alone. Many people resort to doing it
over iCloud. You might think that you'd be able to perform a
function like this by selecting multiple contacts using an Edit
button, tapping a bullet point next to individual contacts and
trashing them. That's how it's done on Messages and Mail, after
all. But, for some reason, Apple hasn't followed suit on Contacts.

Thankfully, there is now an easy way to delete multiple
contacts on iPhone. It combines the drag-select feature of i0OS
16 with the press and hold function that allows you to delete
contacts. This feature is only suitable for deleting groups of
contacts next to each other. You can't select multiple contacts
individually like you'd select multiple individual messages in
Messages. If you've got a lot of spring cleaning to do, you're still
best off deleting multiple contacts oniCloud. You can use this
feature to select more than one group of contacts, though.

To delete multiple contacts on iPhone, open the Contacts
app or the Phone app and tap Contacts. Find a group to delete.
Using two fingers, tap a contact and drag up or down to select
the adjacent contacts. The contacts will then be highlighted
gray. Release your fingers. If you'd like to add on another group
for deletion, repeat step 2. If not, continue pressing with a single
finger and tap Delete [X] Contacts. Finally, tap Delete Contacts.

Image rights: Apple Inc, Getty.



The iPhone has a built-in way to

clear online clutter and let you
see web pages more clearly. It's called
Reader, and it's built into iOS Safari. It's
worth noting that not every website or
web page out there supports Reader,
but many do.

To enable it, open a web page in
Safari and at the bottom of your device
screen, tap the AA icon next to the URL
bar. Tap Show Reader from the menu
that appears. You can also adjust text
size from this menu using the small or
large A buttons. You'll now have a page
in Reader format, with no distractions
and just text and images displayed. To
exit the Reader, and return to the full
page, tap the AAicon again and select
Hide Reader.

Alternatively, if you'd like to set the
Reader to come on whenever it can, go
to Settings > Safari. Tap Reader. Toggle
on All Websites and Safari will now
display any applicable pages in Reader
mode where possible. This is basically
like an automatic ad blocker.

Identify any song

Knowing how to identify any song

oniPhone is something that'll
come in incredibly handy all the time.
Perhaps you're out shopping and hear a

song over the radio; whatever the reason,

using the iPhone’s built-in Shazam app,
you can usually find out exactly what
song itis you're hearing.

What's even better is that you don't
actually need to open Shazam to launch
music recognition (although you can). By
far the quickest and easiest method to
find out a song is to add music
recognition to your Control Center,
meaning it's always just a swipe and tap
away when you're in a rush because the
song is nearly over.

Toidentify any song oniPhone, add
Music Recognition to your iPhone’s
Control Centerin the Settings app — tap
Control Center. Check whether Music
Recognition exists in your Included

Image rights: Apple Inc, Getty.

Create zip files

28 hidden iPhone features

Knowing how to create zip files on iPhone is a useful skill. It allows you to

compress files so they take up less space — potentially saving you the cost of
upgrading to a larger capacity iPhone or having to buy more room on iCloud. Zip files are
also easier to email since you may be able to get below the typical 25MB attachment
limit. What's more, the files you compress can be anything from docs and audio to
images and videos and, since they're placed inside a single file, they start to become
more manageable. For this tutorial, we're concentrating on using the Files app.

Launch the Files app
Open the Files app either by looking
for the Files icon on your Home Screen or
by using Spotlight (swipe down on the
iPhone screen, type Files and tap the
icon when it appears).

Choose a location

Look for the files you want to
compress. You can tap Browse and
choose a location such as iCloud Drive or
On My Phone. You will then be able to tap

: o Compress the files

When you have selected all of the
files you need, tap the More buttonin the
bottom-right corner and select Compress.

Rename the archive
A zip file will be created and this will

 appear in the same folder as the files you

selected. If you press and hold on the zip

- file you can tap Rename and enter a new

filename if you wish.

a folder to view the files within it.

e View and select your files

Once a folder is open, tap the More

button in the top-right corner and tap
Select. Now tap on files that you would

like to include in your compressed zip file.

Not Playing

Controls. If not, scroll down and tap the
green plus symbol next to Music
Recognition. When you hear a song you
like, swipe down from the top of your
screen to open Control Center and then
tap Music Recognition.

Wait a little for the feature to analyze
the sounditis hearing. If the sound is
quiet, it may not work and you may have
to move closer. Once Shazam has picked
up the song, a banner will appear at the

top of the screen. You can either quit now

you know the song, or tap the song
banner to open Shazam, find out more
and see your saved songs. You can now
add that song to your favorite playlist.

Optimise File Size
Create PDF
o Copy 4 ltems
A103 - Tags

Propo...ection
New Folder with 4 Items 9

You'll definitely want to turn of f

autocorrect on iPhone if you're
tired of iOS getting it wrong.
Autocorrect can be notoriously
intrusive and annoying. So much so
that Apple recently promised iOS 17
will make autocorrect better. At the
moment, it's mostly a pain when
you're typing fast — fixing things
preemptively that we don't want to
fix. To put a leash on autocorrect, open
the Settings app and tap General.

Scroll down and tap Keyboard.

Toggle off Auto-Correction. You'll
notice that other useful automated
settings like Auto-Capitalization and
Predictive remain on, so you still have
arange of handy tools to help keep
your textin good order.

Auto-Correction
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Get started with Calendar

"

GET STARTED WITH

Calendar

Take the stress out of having to remember
appointments by using Calendar

THE CALENDAR APP has

v‘ been around on the Mac
in one form or another for

decades. And it’s been part of i0S and
iPadoSs for as long as they’ve existed.
It gets more powerful and useful every
year, yet it remains underused and
underappreciated. Using it habitually
and sharing calendars with friends
and family members really will help
you be better organized and less
stressed as a result.

Image rights: Apple Inc
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At the heart of Calendar is iCal.
Once the name for the app itself,
iCal is the format and behind-the-
scenes service that enables you
to sync, share and subscribe to
calendars. You can download any
file with an .ics extension and add it to
Calendar just by double-clicking it.
Perhaps the real power of Calendar
lies in its integration with other Apple
services such as Maps, Contacts, and
even Siri. For example, if you book

tickets for an event and receive a
confirmation email, Siri can create a
calendar event from the details in the
email and suggest it to you. With one
click, you can add that event to your
Calendar. When you open a Calendar
event with address details in it, you
will see a map of the location and, if
it’s available, a Look Around preview.
Tapping on that takes you to the Maps
app. There’s so much you can do with
Calendar, so let’s get started. m
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If you've never created a calendar, you'll love how easy it is

THE CALENDAR APP can

v‘ host multiple calendars.
These include calendars

you create from scratch and calendars
you import from other accounts such
as Google and Microsoft. If you have,
for example, a Gmail address set up
in Mail, you can add the calendar for
that Google account to the Calendar
app. Friends and family members can
also share calendars with you.

And if you subscribe to public
calendars, like the one that NASA
offers for launches, for example,
these will appear as well. You can
decide in the Calendar app which
calendars of all those available you
want to appear in Calendar. This
is very useful when, for example,
you have duplicate public holiday
calendars because you have both
Google and iCloud accounts.

QUICK LOOK The Calendar interface on Mac

It’s worth paying attention to
color coding when you create new
calendars. Color coding is a great
way to make it easy to tell at a quick
glance which calendar an event
belongs to. However, if you subscribe
to lots of calendars, or have lots of
shared calendars, you can end up
with several of the same color. The
solution is to choose a less—used
color for your own calendars. m
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HOW TO Create your first calendar

Get started with Calendar

Ao g

& i e

R I R T

o iCloud calendar

Click on the Apple menu and
choose System Settings > Internet
Accounts. Click iCloud, then click Show
All. Toggle Calendar to on. The process is
the same for adding other calendars for
Internet Accounts you've already set up.

Cancel New Event Add

Meet Fred to discuss tender

All-day

Starts

14 Jun 2023 15:00

New event, iOS

From any calendar view, tap the
“+" at the top of the screen. Type the
title of the event and add details of
location, time, invitees, and how you
want to be alerted. Add notes and tap
Attachment to add one from Files.

Click to subscribe

On a website hosting the
calendar, click the link to download the
Apple or .ics version. Click Allow in the
dialog box that opens. Click Subscribe
in the next box, choose the options
you want and then click OK to add it.

Image rights: Apple Inc.

< Calendar Accounts

iCloud

iCloud Orive, iCioud Mail, Contacts and 11 more

Gmail

Google Mail

Contacts, Calendars, Notes

Subscribed Calendars

addtocalendar.comfat r=608uln=en-gblvjs

New account, i0OS

Tap the Settings app and then
Calendar. Choose Accounts. Tap Add
Account. If the account type you want
to add is listed, tap it. If not, tap Other.
Sign in to your account, or tap Add
CalDAV Account and add your details.

Fill in details

When the event is added, a
window opens. Click on it and start
typing a location, then choose from the
options. Below the location, add the
end time, travel time, and how you want
to be alerted when it's time to leave.

s 18 June 2023
- Frudey

View your schedule

To see a detailed day view, click
Day at the top of the Calendar window.
You'll see a full breakdown of the current
day. Click an event to see details in the
sidebar on the right. Use the month
calendar to select a different day.

— -

i
P i 2

Add a new event

Click on the File menu and click
New Event, or click the “+" at the top of
the Calendar window. Start typing the
name of the event and the date and
time in plain English. Press Return when
you're done. The event will be added.

Invite people

Double-click on any event to
open the Details window. Click Add
Invitees. Start typing the name of the
person you want to invite. When their
name appears, click on a contact
method. Add more invitees, then Send.

Add notes

Double-click an event to open
its Info window. Click in the notes field
(bottom of the window) and start typing.
To add an attachment, drag it from the
Finder onto Add Attachment. You can
paste a URL in the URL field, too.
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MONDAY

12 JUN

Spider-man into the Spiderverse
Empire Cinemas

TOMORROW

I Deadline for proposal submission

I Meet with Finlay to discuss next steps

WEDNESDAY 14 JUN

I Dentist

THURSDAY 15 JUN

| 1more event

Calendar has multiple widget
options for mac0S and i0S.

Do more with Calendar

Calendar integrates brilliantly with other features of macOS and i0OS

THERE'S A LOT MORE

v‘ you can do with Calendar
than just the basics of

creating and sharing calendars and
entries for your scheduling.

You can choose the kind of access
those you share with have, from
read-only to full editing rights. You
can also create custom alerts as part
of an event so you could, for example,
automatically send yourself an email

HOW TO Automate Calen

or open a document a few minutes
before a meeting begins. You can
incorporate Calendar into Shortcuts
workflows, using actions to create,
edit or get details of events.

Of course, you can use Siri to create
events, but you can also use Siri to
edit events, too. And, if you’re not
near your Mac or iPhone, you can log
in to [ Wwww.icloud.com]in a web
browser and see your calendar there.

dar entries

Widgets on macOS and iOS
are a great way to put upcoming
appointments on your Desktop or
Home screen, so you never miss
them. And integration with Maps
and Weather means that if you add
a location to an event, not only will
it add a map and weather information,
it will take current travel conditions
into account when notifying you that
it’s time to leave. =

Make custom alerts

Double-click any calendar entry
and click on the alert menu. Choose
Custom then Open File. Click the menu

below and choose Other. Navigate to the

file and click Select. Choose a time to
send the alert and click OK.
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Add a shortcut

Launch the Shortcuts app and
choose Gallery. In the “Put it on the
Calendar” section, click Open Upcoming
Event. Click Add Shortcut to add it to
your shortcuts. Go to All Shortcuts
and double-click it to see and edit it.

i

are O et . RS LY
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Choose a trigger

Click the “i" in the sidebar and
choose Details. Choose whether you
want to trigger the shortcut from the
menu bar, Share menu or a Quick Action.
Or click Add Keyboard Shortcut to create
a keyboard shortcut to show events.

Image rights: Apple Inc.
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HOW TO Streamline your calendar

Get started with Calendar

O = iy . 023

Hide all-day events

Decluttering your calendar is key
to seeing the important events. To hide
all-day events, including public holidays,
click on the View menu. If Show All-Day
Events is checked, select it to uncheck it
and hide all-day events.

HOW TO Manage sharing
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Hide calendars

To hide calendars, uncheck
them in the sidebar. If you can't see the
sidebar, click the Calendar icon in the
tool bar. To unsubscribe completely
from public calendars, Ctrl-click on
them and choose Unsubscribe.

Calendars Done
GLE MAIL SHOW ALL
O Holidays in United Kingdom @
Shared by Holidays in United Kingdom
Birthdays ®

Shared by Contacts

Hide calendars, i0OS
In any view, tap Calendars at
the bottom of the screen. Uncheck the
calendars you don't want to appear.
To unsubscribe from a public calendar,
tap Calendars then tap the “i" next to
a calendar and choose Unsubscribe.
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Share a calendar

Choose the calendar you want to
share and Ctrl-click on it. Choose Share
Calendar. Start typing the name of the
person you want to share the calendar
with and select them from the list. Add
more names and click Done.

Image rights: Apple Inc.
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Tweak settings

Ctrl-click on a shared calendar
and choose Sharing Settings. Click on
the Shared With section to add more
sharees or delete one. To manage
settings for a sharee, click on their name
and choose View Only or View & Edit.
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Shared events
Ctrl-click on any event that's
been shared with you. Choose Accept,
Maybe, or Decline from the menu.
To contact everyone who has been
invited, choose Email All Participants
or Message All Participants.

> ALTERNATIVES TO CALENDAR

Finding the perfect date

There are several different options for a calendar app in both mac0S and i0S,
if you decide you don't want to use Calendar. While key features are common
to all, others appear in some apps but not others. So, for example, if you
need an Apple Watch app, or Shortcuts support, make your choice based

on those. Aesthetics are also important in a calendar app because a
well-designed, attractive interface is easier to read at a glance than one
that is cluttered. We've found Fantastical [Attps://fexibits.con) and

Moleskine Timepage (www.moleskine.coml) to be excellent options.
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A total of six USB-A ports
are provided as well as
four display outputs.

THE BOTTOM LINE

Plenty of ports and
power to expand your
Mac, with an emphasis
on USB-A peripherals.
16 ports of expansion
135W total power

D Sensibly priced

&2 Only one USB-C
GREAT BmEN
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Satechi Thunderbolt 4
Multimedia Pro Dock

A powerful dock for legacy devices

$349.99 From[hifps:/satechined

Features Six USB-A ports, 135W total power, four display outputs,
SD and MicroSD card readers Needs Thunderbolt 4 for full speed

SATECHI'S LATEST MULTIMEDIA dock offers
16 ports of expansion for your Thunderbolt
4-equipped Mac with an emphasis on
returning a range of legacy ports to laptops
that may natively feature mostly USB-C. It will
work with Thunderbolt 3 Macs though its
overall throughput will be limited by the speed
of that connection. Shipping with a 135W
power supply. it is able to provide 96W of power
through its main Thunderbolt port which

is enough to charge all but the latest 16-inch
MacBook Pros at full speed.

THE PORT REPORT

The design is a little boxy but it certainly feels
solid and well built, with a detachable foot
included in the box that lets you stand it on
its end for more flexible placement options.
The front panel contains a power button,
3.5mm combined headphone output and

mic input, as well as two USB-A ports, one

at 10Gbps and the other USB2 which can
supply up to 7.5W of power for charging smaller
devices. SD and MicroSD card slots running at
up to 312MBps are also found here which are
handy for photographers.

On the rear is a selection of ports that
you'd typically need to be swapping less
frequently, starting with two more USB-A 3.2
ports at 5Gbps and two at 10Gbps. A single
USB-C port at 10Gbps is also provided so that
total of six USB-A and just one USB-C would
suggest that the dock is probably going to be
more useful for those needing to incorporate
more USB-A devices into their workflow.
There's also a 2.5Gbps Ethernet port which
can be handy since Apple’s laptops haven't
had these for many years.

DISPLAY EXPLANATION
Then we come to the display expansion, which
requires a little explanation. There are two
DisplayPort outputs and two HDMI 2.1 outputs
and these are separated into two groups. While
Windows machines can output four separate
desktops via these ports, Macs are by design
a little different. Put simply, there’s a limit to
how many unique displays certain models
can drive through a single Thunderbolt port.
M1- or M2-powered Macs can drive a single
extended screen while Pro models can drive
two and Max models can drive four. However,
none can drive more than two unique desktops


https://satechi.net

HDMI 2.1

B N =

Gl

Displayport

o

HDMI 2.1

via a single port so if you connected all four
display ports to the dock, two of the screens would
simply mirror your Mac's desktop. But with a
compatible Mac (Pro or Ultra), you could drive
more extended desktops by using the other
Thunderbolt or HDMI ports on your Mac — it just
won't work via the dock. This is also the case with
Intel models and is a feature of Apple’s hardware
rather than of the dock itself.

SOLID WORKHORSE

So your experience here will vary based on

your Mac model. With anything other than an

M1 or M2 Mac you will be able to output two extra

IT FEELS SOLID AND

WELL BUILT, WITH

A DETACHABLE FOOT

THAT LETS YOU STAND

ITONITS END FOR

MORE FLEXIBLE

PLACEMENT OPTIONS

USB 3.2 10G USB 3.2 10G

desktops via the dock, which is decent and
probably adequate for many people. You'll always
be able to mirror your desktop too, though this is
probably mostly useful for presenting rather than
creating. The displays run at up to 4K/60Hz via
the dock, which is enough for many users.

This is a solid and sensibly priced way to
expand your Mac's port selection, especially if you
own a laptop with fewer ports, or all USB-C format
ports. It provides many more USB-A than C ports
which will suit some people more than others, and
there are caveats with the display expansion but
overall it's a great workhorse dock for your set-up.
HOLLIN JONES

USB 3.2 5G
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The speakers use a
Continuous Curved
Cone design.

THE BOTTOM LINE

Stylish and sonically
excellent, the 5010s
are a great solution

for high-end playback.

Rich and detailed
Gorgeous design

Excellent separation

B Needs separate power
EXCELLENT Rmmmi
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0 Acoustics 5010

Serious hi-fi speakers that look and sound amazing

$749 From[www.gacoustics.com|

Features 4.5-inch woofer, 1-inch tweeter, wired-only operation, rear bass port, multiple finishes,
Continuous Curved Cone design, 56Hz-30kHz frequency response

Q ACOUSTICS' 5010 bookshelf speakers
represent the entry-level model in the 5000
series. Beautifully built and coming in a range
of colored finishes, they are straight—up hi-fi
speakers with no computer connectivity, a
pair of binding posts on the rear their only
means of input. They weigh 12.3 1bs and with
dimensions of 10.4 x 6.3 X 10.4 inches are quite
deep, their design allowing for strong bass.

You will want to pair them with a decent
amplifier and also some better-than—average
speaker wire. Proper stands will tighten up
the bass end and increase focus, though these
performed well when desk or shelf mounted,
producing an excellent stereo image even
when not precisely placed.

Internally, the 5010s use a Continuous
Curved Cone design developed to combine
the bass performance of a traditional straight
conic cone with the high—-/mid-range
frequency control of a flared cone. It has a 4.5
inch bass unit and a 1—-inch tweeter with a
2.5kHz crossover and an overall frequency

response of 56Hz-30kHz. There’s also internal
bracing inside the box that minimizes low
frequency vibrations while focusing stereo
imaging and improving the soundstage.

The bass is solid and refined and doesn’t
become boomy even at higher volume levels. If
you prefer a more neutral sound, a pair of foam
bungs can be used to plug the rear-firing bass
ports though it was pleasing to let the low end
sing, especially with electronic music.

The cleverly designed woofers do a great job
of reproducing both low and mid frequencies
without getting muddy, and the tweeters with
their expansive upper range of 30kHz are
crisp. Rock music was punchy and well-
separated, while classical and jazz revealed
every nuance. Cranking up the volume didn’t
cause a noticeable drop-off in clarity either.

The 5010s are excellent speakers with a rich
and accurate sound. Paired with a good
amplifier and placed with a modicum of care,
they offer an affordable way to get into the
world of high-fidelity audio. HOLLIN JONES

Image rights: Q Acoustics.
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Tough testing, trusted ratings

Folder Colorizer PRO

Can this folder icon editor brighten up your desktop?

$4.99 From[hifps:/sofforino.com

Needs macOS 11.0 or later

WITH FOLDER COLORIZER, you’re
no longer restricted to using the
plain blue folder design offered
by macOS. You can change the
folder color, add an icon or emoji or replace
the front with an image drawn from the
libraries of Pixabay, Pexels, and Unsplash
(with over 3.1 million to choose from).
Just drag the folder you wish to modify
on to the app’s sidebar. You can drag

several folders at once, and customize them

all together. You can then use the options
in the toolbar to make your customizations.

The first option, changing the color of
the folder, works well. You can choose from
the colors in the main window, or click the
dropper tool to open a picker for an even
wider range of color options. The newly
colored folder looks great, with the icon’s
details such as fold marks along the bottom
and its far side presented in a deeper
version of the chosen color preserved.

It’s when you take things further with
images, decals and emoji that things fall
apart. Click the Image icon and you’re
shown a huge range of photo library pics.
An excellent search facility covering colors,
decals and emoji as well as photos, helps
you narrow it down. Click on one and the
front of the folder is replaced by the image.
And that’s it. But the app lacks even the
most basic editing tools. You can’t

Folder Colorizer enables you to add photos, and the search
facility is excellent, but there are no editing tools on offer.

Image rights: Softorino Inc.

reposition the image, there’s no way of
masking, cropping or resizing it and you
can’t import your own images from Photos
or elsewhere on your Mac. As the pictures
on offer were clearly not designed to go on
folder icons, they usually look pretty ugly.
The next two tools are for emojis and

decals; these sit much better on the folders.

They actually look like they belong there.
The decals are basically line drawings or
pictures. Again there’s no way of adding
your own, so you’re limited to the selection
on offer. You can put both a decal and an
emoji on a folder, but not two decals or two
emojis. You can overlay decals and emojis
on top of a photo image or background too,
though it looks a little messy.

Folder Colorizer is well presented and
easy to use, but it needs more. The ability
to add your own images and clip art is a no-
brainer. Allow the user to edit pics too, and
you should be able to “badge” a folder with
an offset image. If changing folder colors
is enough, Folder Colorizer might satisfy,
but we suspect many people will grow
frustrated by its limitations. AN OSBORNE

There's a great range
of colors on offer, but
it all goes wrong when
adding images.

THE BOTTOM LINE

It's very functional
and straightforward,
but does too little

to recommend.

Easy to use

Very well presented

2 Can't use own art

B Lacking too
many features

OKmma
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This must be the smallest
and quietest network
storage with a capacity
of 24TB.

THE BOTTOM LINE

Fast on the right
network, compact
and capable.

Compact and silent
High performance

Time Machine support

Full SMB and AFP
AWESOME nmmE®
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Asustor Flashstor

6 FS6706T NAS

SSD network storage and more

$449 From|www.asustor.com

Features Time Machine support, with both SMB and AFP available, compact and almost silent, up to six
M.2 NVMe drives, Dual Superfast 2.5-Gigabit Ethernet ports, speeds of up to 2.9 GHz

ASUSTOR HAS ADDED a pair of SSD-based
systems to its justly popular range of Drivestor
and Lockerstor models. We put a handful of
Samsung’s finest into the smaller of these two
Flashstor NAS and checked how it fared with
Time Machine and sharing for a Mac Studio.

Much of the case encloses six drive slots for
M.2 2280 NVMe SSDs. Simply remove four
small bolts on the underside and you can slip
in up to 247TB (its sibling the Flashstor 12 Pro
doubles the number of slots). Those can be
configured in RAID 0, 1, 5, 6 or 10, or accessed
individually. We challenged the Flashstor 6
with a couple of 2TB drives and one 1TB in its
default RAID 5, to give a total capacity of nearly
2TB and the ability to withstand failure of any
one of the SSDs.

Those drives are cooled by a near-silent fan,
and reached max temperatures of 107.6°F
during testing, but more typically kept below
98.6°F. It uses less than 20W in operation,
about half that of a regular four-bay NAS, and
that falls to under 1W when sleeping. It comes
with 4GB memory as standard, expandable to
16GB. Its two 2.5Gbps Ethernet ports can be
aggregated through a suitable switch to deliver
5Gbps. You can expand its storage through two

USB 3.2 Gen 2x1 ports, and it offers HDMI 2.0b
and S/PDIF audio out for media.

Software setup is easy using Asustor’s free
app to find the NAS and hand over to its
pleasant web interface. One-click setup soon
sets the SSDs to work preparing its storage,
which has the option of using Btrfs if you want
local snapshot backup. Configuring the SMB
service is simple with Samba VFS modules for
better compatibility with macOS, and AFP
support if you need it. Asustor Data Master
software gives access to a seemingly limitless
range of apps for web and media servers,
security camera surveillance, and more.

The Flashstor’s performance is limited by
network bandwidth and the Mac’s SMB. Time
Machine backups ran smoothly, with a peak
write speed of just over 300 MBY/s. A first
backup of nearly 200GB in 1.8 million files
took just over an hour, at an average transfer
rate of 47 MB/s, making it comfortably faster
than an equivalent hard disk NAS such as
Asustor’s Lockerstor.

If you can afford the investment in SSD
storage media and run a faster network,
Asustor’s Flashstor 6 rewards you with silent
speed in a slimline package. HOWARD OAKLEY
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Quad Lock Motorcycle Kit

Sophisticated solution for mounting your iPhone

From $79.99 (with original case and Handlebar Mount) From[www.quadlockcase.com

Features Original twist-lock case or Mag case, Handlebar Mount (PRO option), Mirror Mount,
Fork Stem Mount (PRO option) Needs iPhone 5 or later

NEED A WAY to mount your iPhone to a
motorcycle? Then Quad Lock’s Motorcycle Kit
is one of the best. The kit comes with a Quad
Lock case (available for the iPhone 5 and up)
featuring the trademark twist-lock design.

If you have a newer iPhone with MagSafe,

the Mag case option (an extra $10) works with
the original Lock Mount as well as the later
Mag Mount, offering a slightly more secure
magnetic attachment, as well as being
MagSafe charging compatible. A weather
resistant poncho is also available to protect
from the elements (an extra $20).

Once you’ve chosen a case, select whether
to mount it to the handlebar, mirror, or fork
stem. We went for the handlebar mount,
which attaches to a variety of bar diameters
(7/8”,1”,1-1/8”, 1-1/4”) via two hex screws,
and incudes an adjustable extension arm to
position your iPhone.

By default the mount is made of glass-filled
nylon ($49.99), or for a little extra there’s a
slightly more appealing PRO version made

of CNC-cut, black anodized aluminum
($69.99). The Fork Stem Mount is also
available in the PRO version, but not the
Mirror Mount. Whichever you choose,
there are several optional extras
available at the point of purchase,
including a neat Vibration Dampener
($19.99), and a Weatherproof Wireless
Charging Head ($74.99).

The Vibration Dampener is designed
to protect your camera from excessive
vibrations, thanks to its dual chassis
suspension system, so it’s a bit of an
essential extra, in our mind. The
wireless charger means you don’t have
to plug in the Lightning cable whenever
you attach your iPhone, but it’s pricey.

Installing and adjusting the Handlebar
Mount is very simple, and attaching
your iPhone takes just seconds. It’s
incredibly secure and makes for a
great way to mount your iPhone to
a motorcycle. NICK ODANTZIS

Adjust the arm and get
your iPhone in exactly
the position you like.

THE BOTTOM LINE

Easy to use, very
secure and loads

of options to get the
mount right, but it
all adds up.

D Very secure — Vibration
Dampener is essential

Simple set-up

Easy to fit anywhere

B The options can make it
very expensive overall

EXCELLENT mmmmi
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Sid Meier's Railroads

You won't need a ticket for this ride

$12.99 From[www.feralinteractive.com|

Needs iPhone 6S (2015, A9 chip) or later, iPad 5th generation (2017) or later, iPad Air 3rd generation or later,
iPad mini 5th generation or later, any iPad Pro; i0OS 15.5 or later

FROM 2006 COMES an iOS port of
yet another classic PC game, this
time a railroad tycoon sim in which
you plot steam—based financial
dominance with not a care for the huge
amounts of industrial pollution you’re
inflicting on the world.

And while it’s possible to play your way
through various careers and scenarios, a better
fit for mobile is the Train Table mode, in which
you’re set loose on the landscape with no
goals, infinite cash, and may find yourself
reaching for an engine driver’s cap.

The actual game, in which you play against
up to 20 would-be railroad barons, isn’t
exactly stressful. The process of linking
resources such as farms with cities and trying
to do so as efficiently as possible is an
optimization problem which, mixed with
lovely countryside and the gentle chuff of the
locomotive, can actually be relaxing. You’ll still
swear — often at yourself for failing to foresee
the precise situation you find yourself in,
trying to splice new tracks on to an existing
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As your cities
expand, you'll see
new industries
added to them.

network that doesn’t go in quite the right
direction — but the constant increases in your
wealth thanks to trains shuttling back and
forth between locations makes up for it.

Once you’ve got your rail backbone laid out
— less like a spine and more like the webs
produced by spiders who’ve been given LSD
— the map comes to life, and you’re able to
put down branch lines to connect nodes you’d
overlooked in the first pass, as well as
improving cities by building new industries
in them. There’s the ability to buy and sell
stocks too, hoping to keep your opponents
down by denying them the ability to make
a quick buck, or giving your own finances
a sudden boost if things are looking tight.

Maps include parts of Europe and the US,
and there are 16 scenarios to pit your planning
abilities against. None of them are especially
challenging, though it’s possible to up the
difficulty by introducing rules, like only one
train being allowed in any given spot, that
increases the realism too. Working through
them becomes a matter of time, rather than
attempting to work out a crossword clue with
your mind. The interface has been greatly
changed in the port, the new touch-friendly
way of doing things streamlining the process

b
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Placing track means a simple tap and drag with the finger.

Image rights: Feral Interactive.
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of laying track and
finding out the info
you need that was so
easy with a mouse.

Time moves on and
so does the Industrial
Revolution, opening
up new engines to use
on your tracks, new
methods of powering
them, and patents you
can take out to give your trains a bit more
of an edge against the competition.

THE ROMANCE AND RATIO FACTOR
In fact, it’s all enough to make you wonder
why playing with trains gets such a bad rep in
our always-online, instant gratification world.
Would seeing a network you’ve meticulously
planned out working at peak efficiency feel the
same if you were working with space freighters
or data packets instead of something as
romantic as a steam engine? It might, as the
popularity of games such as Opus Magnum
and Satisfactory show, but there is something
undeniable about steam trains that means a
shack at the bottom of the yard and a thorough
understanding of the 1:43.5 ratio beckons.
Until then, being able to develop a world-
beating rail system on iPad (or iPhone) is the
next best thing, and Railroads is capable of

Tough testing, trusted ratings
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Profit:

eating away at many an afternoon when
you’re supposed to be working, even if
the actual challenge is outweighed by
the simple satisfaction of watching the
engines steaming around. IAN EVENDEN

Charming little animations bring the world to life.

APP TIPS

Keep your trains chuffing along nicely

Tap with precision
You'll find yourself unable to tap the
end of existing track if there's

Keep an eye on congestion
A “parallel track” button helps you
to plan ahead and make sure your
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Display all your routes
to easily see the extent
of your network.

THE BOTTOM LINE

Clear your timetable:
catching this classic
railway sim is a

day trip to some
relaxing gaming.

A classic renewed

Good touchscreen
conversion

Relaxing to play

D Not especially deep
GREAT REEN

character

There are many characters to play

have contributed to

something else in the way. An
Apple Pencil can help.

most important trains can pass
through a busy area unimpeded.

the history of the railways, but they
have no impact on the gameplay.
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The two additional screens
can match your MacBook
Pro's display settings.

THE BOTTOM LINE

An excellent, if pricey,
way to triple your
screen space with
the minimum of fuss.

Triple your screen space
Powers from laptop

Excellent image quality

£ Relatively expensive
EXCELLENT Rmmmi
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Monduo 16 Pro Duo Display

Super size your MacBook Pro monitor

$799 From[www.monduo.cd

Features Two 16-inch IPS displays at up to 2,560 x 1,600 pixels, 144Hz refresh rate, 500 nits of
brightness, 100% DCI-P3 wide color gamut, USB-C power and HDMI

ADDING SERIOUS SCREEN real estate to a
laptop generally requires conventional desk
monitors, but the 16 Pro Duo is a different
proposition. In its folded form it is roughly the
same size and weight as a 16—inch MacBook
Pro — being made of plastic keeps it light.
Open it out and it sits over the back of your
laptop screen, with one side sprung to allow a
snug fit. At the base of the central panel is an
extendible foot which makes the whole thing
steady when placed on a flat surface. The two
screens can be positioned flat or in more of a
curved arrangement.

Each screen has two USB-C ports and an
HDMI port which can carry video and power
from your laptop. For those with fewer ports,
you can run HDMI from one screen to the
other, though you’ll need to power the second
screen separately. The screens can also
accommodate 100W passthrough power, and a
range of cables are included for these setups.

macOS recognizes the new display
automatically and you can use the display’s
settings to arrange them. There are touch
controls on the bezels for brightness, contrast
and other tweaks, though the control panel
app provides easier menu bar control and also

unlocks a higher max resolution than that
stated in the specs.

The Pro Duo display performs very well and
is highly responsive. We found it necessary to
set it to the maximum brightness of 500 nits
and slightly cool the color temperature in
order to match our MacBook Pro. The P3 wide
color gamut looked rich and accurate and
there’s up to 144Hz refresh rate for gamers.
These higher settings did cause our Intel
machine to fire up its fans sometimes, but
that’s not uncommon.

While you’ll want to be powering your
laptop to avoid battery drain, the fact the
display works entirely over two short USB-C
cables is a neat solution.

Adding two 2K screens with minimal cabling
or bulk is a game changer not just for creatives
but anyone juggling multiple apps, and going
back to a single screen feels quite limiting. A
slightly more solid build would be ideal but
would also add to the weight, so it’s
understandable. There’s also the price which is
not inconsiderable, however it’s a unique
product that performs admirably and could
well transform the way you work on your
laptop. HOLLIN JONES

Image rights: Monduo.
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Typinator 9.0

Tough testing, trusted ratings

Powerful text-expander app that speeds up repetitive docs

$29.99 From[hifps:/ergonis.coml
Needs macOS 10.15 or later

WE ALL KNOW how tedious
and time-consuming it can
T be when you repeatedly have to
type certain pieces of text
several times a day, such as your address
or key information. macOS does have an
option in the Keyboard settings panel that
can help, by allowing you to create text
“replacements”. These are short snippets
of text that are automatically replaced by a
longer piece of text when typing — such
as “myweb” instantly expanding to show
your company’s full web address. That’s a
handy time-saver, but this option in
macOS is quite limited, and is really only
suitable for simple, short pieces of text.
However, there are a category of
apps — often called “text—
expanders” — that can take this
process even further. Typinator has long
been one of the most popular text—
expanders, and has recently been updated
to version 9.0. Version 8 of Typinator was
already able to run natively on Macs with
Apple silicon, but version 9 deals with
some additional compatibility issues to
ensure that it is now fully compatible with
Ventura. The program’s interface has also
been updated, opting for the rounded
corners, pastel colors and cute icons used
in Ventura.
On its simplest level, Typinator works in
a similar fashion to text replacements in
macOS. You start by typing a short piece of
text — which Typinator calls an
“abbreviation” — into a small text box.
Beneath this there’s a larger window
where you type the full-length, expanded
version of that text — so, again, the
abbreviation “myweb” could be expanded
into your full web address. Typinator goes
even further, though, as its abbreviations
can also be used to insert graphics files,
such as a company logo, or a picture of a

Image rights: Ergonis Software.

| Johw Smith

(Smith & Smith, Lud )

product. You can also insert HTML code or
dynamic data, such as the current time or
date, which can change all the time.
However, Typinator’s greatest strength
is its ability to use predefined “sets” of
abbreviations. Some sets simply focus on
convenient time-saving abbreviations,

such as expanding “dt” to give the date and
time, while others can automatically switch

between US/UK spellings. There are
specialized sets for working with HTML,
and you can also create your own custom
sets of abbreviations and share them with
colleagues at work.

It can take some time to master all these
features — especially as Ergonis’ 40-page
manual isn’t as clear or concise as it could
be — and rival text-expander apps are
more affordable and easier to use.
However, there’s a trial version available,
so you can experiment with Typinator first
and see if it can speed up the creation of
your business documents before you go
ahead and buy the full version.

CLIFF JOSEPH

o
o
o
o
o
o

Typinator makes light
work of any repetitive
text you need to include
in your document.

THE BOTTOM LINE

There are simpler
text-expander apps,
but Typinator's time-
saving features will
appeal to business
and pro users.

Powerful yet simple
text-expander app

Works with graphics
and dynamic data

Useful pre-defined
sets of abbreviations

2 Complex feature set
GREATEmEN
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@ Reviews

Best of the best

Can't find the hardware or app you're looking for in our reviews section? Then check in

here — we've highlighted the best in every major category, as voted for by us

>HARDWARE

CATEGORY

MESH ROUTER

4K USB-C MONITOR
THUNDERBOLT DOCK
KEYBOARD

PORTABLE PRINTER
PORTABLE HDD

E ‘ NAS DEVICE

WIRELESS CHARGER
DESKTOP SPEAKERS
IN-EAR HEADPHONES
SECURITY CAMERA
SMART SPEAKER
OVER-EAR HEADPHONES
AIRPLAY SOUNDBAR
WEBCAM

PHOTO PRINTER
PORTABLE BATTERY PACK
MOBILE DOCK

OFFICE CHAIR

MOUSE

ACTION CAMERA
DESKTOP MICROPHONE
PORTABLE DAC
PORTABLE SSD
THUNDERBOLT 4 HUB
CD/DVD DRIVE

TRAVEL CHARGER
iPHONE GAME CONTROLLER
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PRODUCT

ASUS ZenWiFi XT9

Ben( EW3280U

CalDigit Thunderbolt Station 4
Cherry KW 9100 Slim for Mac
Epson WorkForce WF-TI0W
Toshiba Canvio Flex 2TB
Asustor Flashstor 6 FS6706T NAS
Belkin BoostCharge Pro Portable
Creative Pebble Pro

Nothing Ear 2

EufyCam 2C (two-pack kit)
HomePod mini

Sony WH-1000XM5

Sonos Beam

AnkerWork B600 Video Bar
Liene 4x6 photo printer

Anker 533

Kensington 8-in-1 USB-C Mobile Hub

Branch Verve

Logitech MX Master 3S

GoPro Hero 11 Black

Cherry UM 9.0 Pro RGB

iFi Go Blu

Crucial X8

Satechi Thunderbolt 4 Slim Hub
NOLYTH External DVD Drive
Mophie 3-in-1travel charger

Razer Kishi v2

aldigit.co

herry-world.col

EPSoN.co

btorage.toshiba.co

psustor.co

pelkin.co

s.creative.co

us.nothing.tec
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BON0S.Co

ensington.co

branchfurniture.co

10pro.co

cherry-world.co

batechi.ne

razer.co

$449.99
$799.99
$379.99
$59.99
$299.99
$79.99
$4h9
$59.99
$59.99
$149
$239.99
$99
$399.99
$4h9
$219.99
$136.99
$49.99
$71.55
$549
$99.99
$500
$139.99
$199
$219.99
$199.99
$39.99
$149.95

$99.99

#201

#169

#199

#208

#185

#197

#210

#197

#204

#209

#17

#176

#197

#187

#191

#190

#198

#190

#201

#198

#202

#209

#189

#203

#205

#204

#202

#203


http://asus.com
http://benq.com
http://caldigit.com
http://cherry-world.com
http://epson.com
http://storage.toshiba.com
http://asustor.com
http://belkin.com
http://us.creative.com
http://us.nothing.tech
http://eufylife.com
http://apple.com
http://sony.com
http://sonos.com
http://ankerwork.com
http://amazon.com
http://us.anker.com
http://kensington.com
http://branchfurniture.com
http://logitech.com
http://gopro.com
https://www.cherry-world.com
http://ifi-audio.com
http://crucial.com
http://www.satechi.net
http://www.amzn.to/3lgFDSD
http://zagg.com
http://razer.com

>i0S/iPadOS APPS

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

PHOTO EDITOR

VIDEO EDITOR
CAMERA

RSS READER
DESKTOP PUBLISHING
NOTE-TAKING
MIND-MAPPING
DOCUMENT SCANNER
CALENDAR

FITNESS

SHOPPING

GRAPHICS

> macO0S APPS

PRODUCT

Things 3

& Scrivener

Spark

@ Pixelmator Photo 2

8 LumaFusion 3.0

. Obscura 3

PN Reeder 5

Affinity Publisher 2

€3 Notability 10

¥ MindNode 7

~= Genius Scan 6.0

£ Fantastical 3

@ Gentler Streak
Grocery 3

Procreate for iPad

ulturedcode.co
iteratureandlatte.co

parkmailapp.co

uma-touch.co!

eeder.app
affinity.serif.co
pingerlabs.co

indnode.co

hegrizzlylabs.co

e = 5 = = T
o 5
=3
@
o @
| E| B
et =
= o I
T [ T
o
3 =
D)

exibits.co

smartgrocery.app

procreate.ar

$9.99 #194
$19.99 #138
Free #190
$4.99 #193

$29.99 (1APs) #186

$9.99 #196
$4.99 #176
$19.99 #206
$8.99 #174
$14.99 #184

Free (IAPs) #182
$4.99/month  #198
Free (IAPs) #199
Free #198

$9.99 #196

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

IMAGE EDITOR

VIDEO EDITOR

SCREEN CAPTURE

MUSIC CREATION
PASSWORD MANAGER
DESKTOP PUBLISHING
BACKUP

VIRTUALIZATION
TIME-TRACKING
NOTE-TAKING

AUDIO AND VIDEO CONVERTER
VIRTUAL PRIVATE NETWORK

PRODUCT

Things 3

& Scrivener

Spark

& Pixelmator Pro 3
a Wondershare Filmora
% ScreenFlow 9

B Logic Pro

(s) Secrets

B Adobe InDesign
[# Carbon Copy Cloner
E] Paraliels Desktop 18
@ Tyme3

/A Agenda

@ Wondershare UniConverter

@) NordveN

ulturedcode.co

iteratureandlatte.co

ksparkmailapp.co

pixelmator.co!

ondershare.co

elestream.n
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D
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pdobe.co

hombich.co

ondershare.co

ordvpn.co

$49.99 #194
$49 #200
Free #190
$49.99 #208
$109.99 #202
$129.00 #164
$199.99 #141

$19.99 #188

$20.99/month  #162
$39.99 #136
From $99.99 #201
$3.99/month  #169
Free #204
$49.99/year #203

$11.95/month #186

SEP 2023 | 77


http://www.culturedcode.com
http://www.literatureandlatte.com
http://www.sparkmailapp.com
http://pixelmator.com
http://www.luma-touch.com
http://www.obscura.camera
http://www.reeder.app
http://affinity.serif.com
http://www.gingerlabs.com
http://mindnode.com
http://www.thegrizzlylabs.com
http://www.flexibits.com
http://www.gentler.app
http://www.smartgrocery.app
http://www.procreate.art
http://www.culturedcode.com
http://literatureandlatte.com
http://www.sparkmailapp.com
http://www.pixelmator.com
http://www.wondershare.com
http://www.telestream.net
http://www.apple.com
http://www.outercorner.com
http://www.adobe.com
http://www.bombich.com
http://www.parallels.com
http://www.tyme-app.com
http://www.wondershare.com
http://www.nordvpn.com
http://agenda.com
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